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1Introduction

Welcome to the Xerox WorkCentre 3315DN/3325DN/3325DNI System Administrator Guide. This 
chapter includes:
• Who should use this Guide? on page 10
• Machine Overview on page 11
• Control Panel Overview on page 12
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Who should use this Guide?
Who should use this Guide?

This guide is intended for System Administrators who need to install, setup and manage printers and 
other services on their network.

To use the procedures in this guide effectively, System Administrators must have previous experience 
working in a network environment and must possess Supervisor, Administrator, Account Operator, or 
equivalent rights to the network. They must also have prior knowledge of how to create and manage 
network user accounts.
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Machine Overview
Machine Overview

The Xerox WorkCentre 3315DN/3325DN/3325DNI are multi-function machines which are capable of 
being used for copying, printing, faxing, scanning and e-mailing. The features and functions available 
on your machine depend on the model you have purchased.

Product Configurations

Note The internal Mass Storage Device (HDD) is used on the WorkCentre 3325DN/3325DNI 
models to support Secure Print, Delayed Print, Proof Print, Spooling of Scan to FTP/SMB jobs and 
Stored Jobs, and to provide an increased capacity for downloaded fonts.

Component WorkCentre 
3325DNI

WorkCentre 
3325DN

WorkCentre 
3315DN

Duplex Automatic Document Feeder (50 sheets) Standard Standard Not Applicable

Automatic Document Feeder (50 sheets) Not Applicable Not Applicable Standard

Paper Tray 1 (250 sheets) Standard Standard Standard

Bypass Tray (50 sheets) Standard Standard Standard

Paper Tray 2 (520 sheets) Optional Optional Optional

Copy Standard Standard Standard

Scan to SMB and FTP Standard Standard Not Applicable

Network Printing Standard Standard Standard

E-mail Standard Standard Standard

Scan Standard Standard Standard

Scan To and Print From USB Standard Standard Standard

Fax Standard Standard Standard

USB Memory Device Port Standard Standard Standard

Memory Expansion (Option) 512MB 512MB 256MB

Mass Storage Device (HDD) 2GB 2GB Not applicable

Wireless Enabled Standard Not Applicable Not Applicable
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Control Panel Overview
Control Panel Overview

.

Copy: Activates Copy mode.

Scan: Activates Scan mode.

E-mail: Activates E-mail mode.

Fax: Activates Fax mode.

Display Screen: Displays all the available programming features, plus general machine 
information.

Status / Wireless LED: The color of the LEDs indicates the machine’s current status. For 
more information refer to the User Guide. (Wireless is supported on the 3325DNI only).

Paper Supply: Used to select a paper tray for the copy job.

2 Sided: Used to select whether your originals are 1 sided or 2 sided, or to produce 1 or 2 
sided output.

Job Status: Displays job options for active and saved jobs. You can print or delete active 
jobs or saved jobs:

Machine Status: Accesses machine information, status information, the machine serial 
number and various reports to print.

Menu: Enters Menu Mode and enables you to access options and settings.

Arrows: The up/down and left/right arrows are used to scroll through the options available 
in the selected menu, and to increase or decrease values.

OK: Confirms the selection on the screen.
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Control Panel Overview
Back: Used to go back one level in the menu.

Address Book: Used to search for stored fax numbers or e-mail addresses.

Manual Dial + .com: In Fax mode opens the fax line. In E-mail mode provides access to 
commonly used e-mail address text, for example .com or .org. The text available can be 
customized using CentreWare Internet Services.

Keypad: Used to enter alphanumeric characters.

Pause / Redial: In standby mode redials the last number. In edit mode inserts a pause into 
a fax number.

‘C’ Cancel Entry: Cancels the previous entry made on the keypad.

Interrupt Printing: Interrupts the current job to run a more urgent job. 
(Not applicable to the 3315DN)

Clear All: Clears the last selections made.

Power Saver: Sends the machine into power saver mode or power down. Press the button 
again to restart a powered off machine.

Stop: Pressing the Stop button stops the job in progress. Pressing Stop also exits the Menu 
Mode. If you have logged in to use the machine, pressing Stop will bring up the Log Out 
option. 

Start: Activates a job.
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Control Panel Overview
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2Machine Connection

This chapter shows you how to connect your machine to a network and configure the Ethernet settings 
and includes:
• Machine Parts and Connection Ports on page 16
• CentreWare Internet Services on page 23
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Machine Parts and Connection Ports
Machine Parts and Connection Ports

Front View

Automatic Document Feeder Cover Bypass Tray

Automatic Document Feeder Width Guides Output Tray

Automatic Document Feeder Input Tray Control Panel

Automatic Document Feeder Output Tray Bypass Tray Extension

Front Cover Bypass Tray Width Guides

Control Board Cover Output Tray Support

Handle Document Glass Cover

Paper level Indicator Document Glass

Paper Tray 2 (Optional) USB Memory Device Port

Paper Tray 1
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Machine Parts and Connection Ports
Rear View

Interface Ports

Front

USB Port

This port is provided for connection to a USB flash drive and is used as an input port for printing jobs, 
storing jobs and performing a software upgrade.

Rear

Network Port
This port is used to connect the machine to the network.

Network Port Rear Door

Power Switch Paper Tray Rear Cover

Power Receptacles Telephone Line Socket

Duplex Unit Extension Telephone Socket
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Machine Parts and Connection Ports
Telephone Line Socket
This port is used to connect the machine to a telephone or fax line.

Extension Telephone Socket (Ext. Port)
This port is used to allow a handset to be connected to the machine.

Initial Connection

The On/Off switch and the power outlet are at the rear of the machine. Follow these steps to physically 
connect your machine to the network:

1. Connect the power cord to the machine and a suitable power supply outlet. The power cord must 
be plugged into a grounded power socket.

2. The WorkCentre 3325DNI will connect to a wireless network, if available, when powered on.

Note The machine will not connect to the wireless network while the network cable is attached. 

3. Connect the network cable if required. 
4. To allow faxing, connect the telephone line to the LINE Connector.

Installation Wizard

1. On initial power on the Installation Wizard runs. The Language menu displays.
2. Press the Up/Down arrow buttons to highlight the required language and press OK.
3. The Format Date menu displays. Press the Up/Down arrow buttons to highlight one of the 

following and press OK:
• MM/DD/YYYY
• DD/MM/YYYY
• YYYY/MM/DD

4. The Set Date menu displays. 
a. Press the buttons on the keypad to enter the date or press the Up/Down arrow buttons to 

increase or decrease the value shown on the screen.
b. Press the Left/Right arrow buttons to move from one section of the date to another.
c. When you have entered the date press OK.

5. The Format Time menu displays. Press the Up/Down arrow buttons to highlight one of the 
following and press OK:

• 12 Hour
• 24 Hour

6. The Set Time menu displays. Press the buttons on the control panel to enter the time and press 
OK.

7. The Metric Defaults menu displays. Press the Up/Down arrow buttons to select one of the 
following and press OK:

• Inches
• mm

8. The Default Paper Size menu displays. Press the Up/Down arrow buttons to select one of the 
following and press OK:
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Machine Parts and Connection Ports
• Letter
• A4

9. The Customer Support menu displays. 
a. Press the Up/Down arrow buttons to select Enter Cust. Support #. 
b. The Enter Cust. Support # screen displays. Enter the telephone number of your customer 

support centre.
c. Press OK.
d. The Enter Supplies Order # screen displays. 
e. Enter the telephone number to order supplies. 
f. Press OK.

10. The Optional Fax Setup menu displays. Press the Up/Down arrow buttons to select one of the 
following and press OK:

• Continue with Fax Setup
• Skip Fax Setup - go to step 14.

11. The 1/3 Fax Phone Num menu displays. Enter the fax number of the machine and press OK.
12. The 2/3 Fax ID menu displays. Enter the fax id of the machine and press OK.
13. The 3/3 Country menu displays. Press the Up/Down arrow buttons to select the required country 

and press OK.
14. The machine reboots and the Initializing screen displays.

Administrator Access

Certain features accessed at the machine may require Administrator access to change the settings.

Access to the Feature Defaults, System Setup and Network Settings areas are usually password 
protected.

1. Press the Machine Status button on the control panel.
2. Press the Up/Down arrow buttons to highlight the required option.
3. Press OK.
4. If required, enter the Administrator Password using the alphanumerical keypad. The default is 

1111. 

Note After entering a character press the Right arrow button to enable the next character to be 
entered.

5. Press OK. Once the password is verified, the selected option menu displays.

Wireless Connectivity (WorkCentre 3325DNI)

The WorkCentre 3325DNI is compatible with 802.11 (Wi-Fi®) wireless networks, when used with an 
external wireless adapter 802.11 Ethernet Bridge. The location where the machine is installed must be 
covered by an 802.11 wireless network. This is typically provided by a nearby wireless access point or 
router, which is physically connected to the wired Ethernet that serves the building.
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Machine Parts and Connection Ports
The machine supports connectivity via a wireless only connection if required. The machine will 
automatically configure wireless networking when powered on. 

Note The machine will not connect to the wireless network while the network cable is attached. 

There are several ways to configure Wireless Connectivity:
• At the Machine. For instructions refer to Configure Wireless Connectivity at the Machine: on 

page 20.
• Using Internet Services. For instructions refer to Configure Wireless Connectivity Using 

Internet Services (WorkCentre 3325DNI) on page 24. 
• With the Wireless Setting Program. For instructions refer to Wireless Setup (WorkCentre 

3325DNI) on page 44. 

Configure Wireless Connectivity at the Machine:
1. Press the Machine Status button.
2. Press the Up/Down arrow buttons to highlight Network Settings and press OK.
3. Enter the Administrator Password using the alphanumerical keypad. The default is 1111. Refer to 

Administrator Access on page 19.

4. Press the Up/Down arrow buttons to highlight Wireless and press OK. The options are:
• Wi-Fi ON/OFF - allows you to enable or disable wireless connectivity.
• WPS Settings - allows you to select the Wi-Fi Protected Setup - the options are PBC or PIN.
• WLAN Settings - allows you to use a Wizard to find the wireless network name automatically, 

or use the Custom feature to enter the SSID (Service Set Identifier) information manually.
• WLAN Default - allows you to restore the default wireless settings.
• WLAN Signal - allows you view the strength of the wireless connection.

4. At the Wireless menu, press the Up/Down arrow buttons to select Wi-Fi ON/OFF and press OK. 
Ensure that On is selected and press OK.

5. Press the Up/Down arrow buttons to select WLAN Settings and press OK. The options are:
a. Select Wizard - to have the machine find the WPS Settings automatically. If you select this, 

the Searching WLAN screen displays and the machine searches the wireless network.
• Select your wireless network and click OK.
• Enter the wireless security information if requested and click OK.
• Select Yes to apply the changes.
b. Select Custom - to edit the SSID information manually. If you select this option the Edit 

SSID screen displays. 
• Enter the SSID using the keypad and click OK.
• Select the Operation Mode and click OK.
• Select the Channel and click OK.
• Select the Channel MHz and click OK.
• Select the WLAN Security if required and click OK.
• Select the Authentication if required and click OK.
• Enter the WEP Key if required and click OK.
• Select Yes to apply the changes.
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Configure Ethernet Settings

The Ethernet interface will automatically detect the speed of your network. The machine supports 
hub/switch speeds of:

• Automatic
• 10 Mbps Full-Duplex
• 100 Mbps Full-Duplex
• 10 Mbps Half-Duplex
• 100 Mbps Half-Duplex
• 1 Gbps Full

Set the Ethernet speed on the machine to match the speed set on your hub or switch:

Setting the Ethernet Speed at the Machine

1. Press the Machine Status button.
2. Press the Up/Down arrow buttons to highlight Network Settings and press OK.
3. Enter the Administrator Password using the alphanumerical keypad. The default is 1111. Refer to 

Administrator Access on page 19.
4. Press the Up/Down arrow buttons to highlight Ethernet Speed and press OK.
5. Press the Up/Down arrow buttons to highlight one of the following speeds:

• Automatic
• 10 Mbps Half
• 10 Mbps Full
• 100 Mbps Half
• 100 Mbps Full
• 1 Gbps Full

6. Press OK. The Saved screen displays followed by the Reboot Required message.
To reboot the machine, press the power switch off, wait two seconds and press the power switch 
back on.

To set the Ethernet Speed using Internet Services, refer to Setting the Ethernet Speed Using Internet 
Services on page 26.

Print a Configuration Report

The Configuration Report details the machine software versions and network settings configured for 
the machine.

Print a Configuration Report at the Machine

1. Press the Machine Status button.
2. Press the Up/Down arrow buttons to highlight Information Pages and press OK.
3. Press the Up/Down arrow buttons to highlight Configuration Page and press OK.
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Press the Left/Right arrow buttons to highlight Yes and press OK. The Printing screen displays and the 
configuration report will print.

You can also print the Configuration Report using Internet Services. Refer to Status on page 139.

Install the Additional Memory Card

The machine supports memory expansion through the installation of an additional memory card. 
Memory expansion is an option for the machine.

The machine has a dual in-line memory module (DIMM). Use this memory module slot to install 
additional memory.

1. Turn the machine off and unplug all cables from the machine.
2. Grasp the control board cover and remove it.
3. Remove the new memory module from its bag.

4. Holding the memory module by the edges, align the memory module on the slot at about a 30-
degree tilt. Make sure that the notches of the module and the grooves on the slot fit each other.

5. The notches and grooves illustrated above may not match those on an actual memory module 
and its slot.

6. Press the memory module into the slot with care until you hear a ‘click’.
7. Do not press the memory module strongly or the module may be damaged. If the module does 

not seem to fit into the slot properly, carefully try the previous procedure again.
8. Replace the control board cover.
9. Reconnect the power cord and machine cable and turn the machine on.
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CentreWare Internet Services

CentreWare Internet Services (Internet Services) is the embedded HTTP server application that resides 
in the machine. Internet Services allows an administrator to change network and system settings on 
the machine from the convenience of their workstation.

Many features available on your machine will need to be set via the machine and CentreWare Internet 
Services.

System Configuration

To use CentreWare Internet Services, you need to enable both TCP/IP and HTTP on the machine. See 
Configure Static IPv4 Addressing using the Machine User Interface on page 28, or Configure Dynamic 
IPv4 Addressing using the Machine User Interface on page 29.

To enable HTTP at the machine:

Note HTTP is enabled by default.

1. Press the Machine Status button.
2. Use the up/down arrows to select Network Settings.
3. Enter the Administrator password.
4. Use the up/down arrows to select HTTP Activate.
5. Select On.
6. Press OK. The Saved screen will appear and then the Reboot Required screen will appear.
7. Press the power switch off, wait two seconds and press the power switch back on.

Administrator User Name and Password

Many of the features available within CentreWare Internet Services will require an Administrator user 
name and password. The default user name is admin and the default password is 1111.

Internet Services Administrator Access

To access Internet Services Properties and change settings you will need to login as Admininstrator.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter. The Home page appears.
There are two ways to access Internet Services with the administrator login:
• Select Login at the top of the screen
• Select the Properties icon

3. Enter the Administrator User Name (admin) and Password (1111).
4. Click Login. Click Properties.
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Change the Administrator Password

It is recommended that you change the default administrator password to a more secure password, so 
this Xerox machine is not compromised.

To change the Administrator password:

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side, select System Security. 
6. Select the System Administrator link.
7. In the Access Control area:

a. Ensure Web UI Access Control Enable checkbox is selected. 
b. In the Login ID field, enter a new login name. 
c. Select the Change password box to change the password. In the Password field, enter a new 

numeric password.
d. Enter the password again in the Confirm Password field.

CAUTION: Do not forget the password or you could be completely locked out of the system, 
requiring a service call.

8. Select Apply to save the changes.
9. Select OK when the acknowledgement message displays.
10. Select the Advanced button. The Advanced Access Control screen appears. 
11. Select the number of days for the Password Expires In: option.
12. Select Protect Login IPv4 Address to enable this feature if required, and enter an IPv4 Address in 

the box.
13. Select the required option for the Login Failure Policy, for users who fail to login several times. The 

options are: Off, 3 times or 5 times.
14. Select the required option for Auto Logout. The options are 5, 10, 15 or 30 minutes.
15. Select Security Settings Reset if required.
16. Select Save to save your changes.

For further information, refer to Administrator Accounts on page 114.

Configure Wireless Connectivity Using Internet Services (WorkCentre 3325DNI) 
Note The machine will not connect to the wireless network while the network cable is attached. 

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
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3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Network Settings link, select the Wireless link.
6. The Connection Status shows the Link Status of the wireless connection.
7. The Wireless Settings area provides options to configure wireless connectivity. The options are 

Easy Wireless Settings and Advanced Settings, and are explained below. 

Use the Easy Wireless Settings Wizard

1. Select the Easy Wireless Settings Wizard button to have the machine find the WPS Settings 
automatically. The SSID screen appears with a list of available wireless networks.

2. Select the required Network Name SSID and click Next.
3. If encryption is required, 

a. Enter the WPA Shared Key.
b. Enter the Confirm Network Key and click Next.

4. The Wireless Setup Confirmation screen appears. Click Apply. 

Configure Advanced Wireless Settings

1. Select the Advanced Settings Custom button. The Advanced Wireless Setup screen appears.
2. To enable Wireless Radio, select On from the Wireless Radio menu.
3. Select the required option for SSID:

• Select Search List and select the required network from the drop-down menu. Click the 
Refresh button to update the list of networks available.

• Select Insert New SSID to enter a new wireless network name. 
4. Select the required Operation Mode: 

• Select Ad Hoc to communicate on the wireless network without a wireless access point. Select 
the required channel from the Ad-Hoc Channel menu.

• Select Infrastructure to connect to a wireless access point.
5. In the Security Setup area:

a. Select the required method of Authentication. 
b. Select the required method of Encryption.

6. Depending on your selections you may be required to enter some or all of the following 
information for the Network Key Setup.
a. Select the required option for Using Key.
b. The Hexadecimal option may be enabled. Click the Hexadecimal checkbox to deselect if 

required.
c. Enter the required Network Key and Confirm Network Key.

7. Select Apply to save the changes. 
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Setting the Ethernet Speed Using Internet Services

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Network Settings link select the General link. 
6. Select one of the following speeds from the Ethernet Speed drop-down menu:

• Automatic
• 10 Mbps (Half Duplex)
• 10 Mbps (Full Duplex)
• 100 Mbps (Half Duplex)
• 100 Mbps (Full Duplex)
• 1 Gbps (Full Duplex)

7. Select on Apply to save the changes.
The change to Ethernet Speed rate will take effect after System Reboot screen appears. 

8. Select OK.
9. When the Acknowledgement screen displays, select OK.
10. Reboot the machine.
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3Network Installation

This chapter covers the following topics:
• TCP/IP on page 28
• Unix on page 33
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TCP/IP

These instructions show you how to configure the following via Internet Services:
• TCP/IP v4 and v6
• Domain Name
• DNS
• Zero Configuration Networking

The machine supports TCP/IP versions 4 and 6. IPv6 can be used instead of or in addition to IPv4.

IPv4 and IPv6 settings can be configured directly at the machine user interface, or remotely, via a web 
browser using Internet Services. To configure TCP/IP settings using Internet Services, refer to Configure 
TCP/IP Settings using Internet Services on page 30.

Configure Static IPv4 Addressing using the Machine User Interface

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Existing operational network utilizing the TCP/IP protocol.
• Ensure that the machine is connected to the network.
• Static IP Address for the machine.
• Subnet Mask Address for the machine.
• Gateway Address for the machine.
• Host Name for the machine.

Procedure

Enter a Static IP Address:
1. Press the Machine Status button on the control panel.
2. Press the Up/Down arrow buttons to highlight Network Settings; press OK.
3. Enter the Administrator Password using the alphanumerical keypad. The default is 1111. Refer to 

Administrator Access on page 19.
4. Press the OK button; the Network Settings menu displays.
5. Press the Up/Down arrow buttons to highlight TCP/IP(IPv4); press OK.
6. Press the Up/Down arrow buttons to highlight Static; press OK.
7. Press the Up/Down arrow buttons to highlight IPv4 Address; press OK.
8. Enter the IP Address using the alphanumerical keypad; press OK.
9. Enter details for Subnet Mask using the alphanumerical keypad; press OK.
10. Enter details for Gateway using the alphanumerical keypad; press OK.
11. The Saved screen will display and return to the Network Settings menu.
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DNS Configuration:
12. From the Network Settings menu, press the Up/Down arrow buttons to highlight TCP/IP(IPv4); 

press OK.
13. Press the Up/Down arrow buttons to highlight Static; press OK.
14. Press the Up/Down arrow buttons to highlight Primary DNS; press OK.
15. Enter details for Primary DNS using the alphanumerical keypad; press OK. The Saved screen will 

display and return to the Static menu.
16. Press the Up/Down arrow buttons to highlight Secondary DNS; press OK.
17. Enter details for Secondary DNS using the alphanumerical keypad; press OK. The Saved screen 

will display and return to the Network Settings menu.

Configure Dynamic IPv4 Addressing using the Machine User Interface

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Existing operational network utilizing the TCP/IP protocol.
• DHCP or BOOTP Server should be available on the network. 
• Ensure that the machine is connected to the network.

Procedure

Installation via DHCP (Dynamic Host Configuration Protocol)

DHCP is enabled on the machine by default. If the machine is connected to the network, the TCP/IP 
information will be configured when the machine is powered on and no further configuration is 
required.
1. Print a Configuration Report to verify that the information was assigned correctly. Refer to Print 

a Configuration Report on page 21.

Installation via BOOTP or DHCP

Ensure your machine is connected to the network with Ethernet cabling.
1. Press the Machine Status button on the control panel.
2. Press the Up/Down arrow buttons to highlight Network Settings; press OK.
3. Enter the Administrator Password using the alphanumerical keypad. The default is 1111. Refer to 

Administrator Access on page 19.
4. Press the OK button, the Network Settings menu displays.
5. Press the Up/Down arrow buttons to highlight TCP/IP(IPv4); press OK.
6. Press the Up/Down arrow buttons to highlight DHCP; press OK.
7. The Saved screen will display and return to the Network Settings menu.
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Configure TCP/IP Settings using Internet Services

IPv4
1. At your workstation, open the web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Network Settings link select TCP/IPv4 from the directory tree. The TCP/IPv4 page displays.
6. In the Assign IPv4 Address menu, select Automatically or Manually.
7. If Manually is selected, in the TCP/IP Settings area enter details of the machine in the following 

fields:
a. IPv4 Address
b. Subnet Mask
c. Gateway Address 
If Automatically is selected, select BOOTP or DHCP.

Notes:
• If BOOTP or DHCP mode is selected, you cannot change the IP Address, Network Mask, 

or Router/Gateway Address. Select Auto IP if required.
• New settings will not be applied until the machine is rebooted. Changing the machine’s 

TCP/IP setting may cause you to lose your connection to the machine.
8. In the Domain Name area:

a. Enter a domain name in the Domain Name field.
b. Enter an IP address in the Primary DNS Server and Secondary DNS Server fields.
c. Select the Enabled box to enable Dynamic DNS Registration if required.

Note: If your DNS Server does not support dynamic updates there is no need to select Enabled.

9. In the WINS area select the box to enable WINS and enter details in the following fields:
a. Primary WINS Server
b. Secondary WINS Server

10. Select Apply to save the changes.
11. Select OK when the acknowledgement message displays.

IPv6
1. At your workstation, open the web browser and enter the IP Address of the machine in the 

Address Bar.
2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
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5. In the Network Settings link select TCP/IPv6 from the directory tree.
6. Select the Enabled checkbox to enable IPv6 protocol.
7. To set a manual address, select Enable Manual Address and enter the address and prefix in the 

Address/Prefix area. Information in the Assigned IPv6 Addresses box is automatically 
populated.

8. The machine performs auto-address DHCPv6 configuration every time it powers up. This is used 
for neighbor discovery and address resolution on the local IPv6 subnet. However, you can choose 
to use manual configuration, automatic configuration or a combination of automatic and manual 
configuration.
In the Default Dynamic Host Configuration Protocol Version 6 (DHCPv6) area, select one of the 
following options:

• Use DHCP as directed by a router - this option is fully automatic. The DHCPv6 Address 
will be obtained and displayed on the screen.

• Always Enable DHCP - this option is fully automatic. The DHCPv6 Address will be 
obtained and displayed on the screen.

• Never use DHCP - when this option is selected, you must configure the Manual Address 
Options and DNS separately.

9. In the Domain Name System Version 6 (DNSv6) area:
a. Enter valid details in the IPv6 Domain Name field.
b. Enter an IP addresses for the Primary DNSv6 Server Address and Secondary DNSv6 Server 

Address.
c. Check the Dynamic DNSv6 Registration checkbox to enable this option.

Note: If your DNS Server does not support dynamic updates there is no need to enable DDNS.

10. Select Apply to save the changes.
11. Select OK when the acknowledgement message displays.

Note: Enabling or disabling the TCP/IPv6 protocol will take effect after the system is rebooted. 
Enabling or disabling TCP/IPv6 will impact other protocols, for example LPR/LPD, SNMP, Raw 
TCP/IP Printing and DHCPv6 over TCP/IPv6.

Test Access
1. At your workstation, open the Web browser and enter the TCP/IP Address of the machine in the 

Address bar. Press Enter.
If you use the domain name to specify the machine, use the following format.
http://myhost.example.com
If you use the IP address to specify the machine, use one of the following formats depending on 
your machine configuration. An IPv6 address needs to be enclosed in square brackets.
IPv4: http://xxx.xxx.xxx.xxx
IPv6: http://[xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx]

Note: If you have changed the port number from the default port number “80”, append the 
number to the Internet address as follows. In the following examples, the port number is 8080.

Domain name: http://myhost.example.com:8080
IPv4: http://xxx.xxx.xxx.xxx:8080
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IPv6: http://[xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx]:8080
2. Verify that the home page of Internet Services is displayed.

The Internet Services installation process is now completed.

Note: When your access to Internet Services is encrypted, enter “https://” followed by the Internet 
address, instead of “http://”.
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HP-UX Client (Version 10.x)

HP-UX workstations require specific installation steps to communicate with the machine. The machine 
is a BSD-style UNIX printer, whereas HP-UX is a System V-style UNIX. 

IMPORTANT: All UNIX commands are case sensitive, so enter the commands exactly as they are 
written.

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Existing operational network utilizing the TCP/IP protocol.
• Ensure that the machine is connected to the network.
• Static IP Address for the machine.
• Subnet Mask Address for the machine.
• Gateway Address for the machine.
• Host Name for the machine.

Procedure
1. Follow the steps in Configure Static IPv4 Addressing using the Machine User Interface on page 28, 

then return to this page.

Configure the Client
1. Add the machine Host Name to the etc/hosts file on the HP-UX workstation.
2. Ensure that you can ping the machine from the HP-UX workstation.
3. Use either the GUI method or the tty methods as detailed below:

GUI Method
1. Open a Command window from the desktop.
2. Enter su to access Super User mode.
3. Enter sam to start the System Administrator Manager (SAM).
4. Select the Printers and Plotters icon.
5. Select lp spooler.
6. Select Printers and Plotters.
7. Select Actions: Add Remote Printer/Plotter....
8. Enter the following information into the Add Remote Printer/Plotter form:

a. Printer Name: printer name. 
Where printer name is the name of the queue being created.
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b. Remote System Name: hostname.
Where hostname is the machine hostname from the /etc/hosts file.

c. Select Remote Printer is on a BSD System.
d. Select OK to complete the form.

9. Select Yes at the Configure HP UX Printers Subpanel screen. This screen may be obscured by the 
Add Remote Printer/Plotter form.

10. Select File: Exit.
11. Select File: Exit Sam.
12. Enter Exit to exit Super User mode.
13. Test the queue created, by entering the command: 

lp -d queuename /etc/hosts. 
14. Verify that the job prints at the machine.

tty Method
1. Enter su to access Super User mode.
2. Enter sh to run the Bourne shell.
3. Enter lpshut to stop the print service.
4. Create the print queue by typing (on the same command line):

lpadmin -pqueuename> -v/dev/null -mrmodel -ocmrcmodel -osmrsmodel -ob3 -orc -
ormhostname -orplp

Where queuename is the name of the queue being created and hostname is the machine 
hostname.

5. Enter lpsched to start the print service.
6. Enter enable queuename to enable the queue to print to the machine.
7. Enter accept queuename to the queue accepting jobs from the HP-UX workstation.
8. Enter Exit to exit the Bourne shell.
9. Enter Exit to exit Super User mode.
10. Test the queue created, by entering the command:

lp -d queuename /etc/hosts.
11. Verify that the job prints at the machine.

Solaris 2.x

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Existing operational network utilizing the TCP/IP protocol.
• Ensure that the machine is connected to the network.
• Static IP Address for the machine.
• Subnet Mask Address for the machine.
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• Gateway Address for the machine.
• Host Name for the machine.

Procedure

Follow the steps in Configure Static IPv4 Addressing using the Machine User Interface on page 28 then 
return to this page.

Configure the Client
1. Add the machine printer Host Name to the etc/hosts file.
2. Ensure that you can ping the machine.
3. Use either the GUI method or the tty method as detailed below:

GUI Method
1. Open a Command window from the desktop.
2. Enter su to access Super User mode.
3. Enter admintool to run the System Administrator Tool.
4. Select Browse:Printers.
5. Select Edit:Add:Access to Printer....
6. Enter the following information into the Access to Remote Printer form:

a. Printer Name: queuename. 
Where queuename is the name of the queue being created.

b. Print Server: hostname. 
Where hostname is the machine hostname from the /etc/hosts file. 

c. Select OK to complete the form.
7. Enter sh to run the Bourne shell.
8. Enter the command: lpadmin -p queuename -s hostname !lp to modify the remote queuename.
9. Enter Exit to exit the Bourne shell.
10. Enter Exit to exit Super User mode.
11. Test the queue created, by entering the command: 

lp -d queuename /etc/hosts.
12. Verify that the job prints at the machine.

tty Method
1. Enter su to access Super User mode.
2. Enter sh to run the Bourne shell.
3. Define the machine as a BSD style printer, by entering the command: 

lpsystem -t bsd hostname
Where hostname is the machine hostname from the /etc/hosts file.

4. Create the queue, by entering the command:
lpadmin -p queuename -s hostname -T unknown -I any
where queuename is the name of the queue being created.

5. Enter Exit to exit the Bourne shell.
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6. Enter Exit to exit Super User mode.
7. Test the queue created, by entering the command: 

lp -d queuename /etc/hosts.
8. Verify that the job prints at the machine.

SCO

SCO UNIX workstations require specific installation steps to communicate with the machine. The 
machines are BSD-style UNIX printers, whereas SCO is a System V-style UNIX.

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Existing operational network utilizing the TCP/IP protocol.
• Ensure that the machine is connected to the network.
• Static IP Address for the machine.
• Subnet Mask Address for the machine.
• Gateway Address for the machine.
• Host Name for the machine.

Procedure

Follow the steps in Configure Static IPv4 Addressing using the Machine User Interface on page 28, 
then return to this page.

Configure the Client
1. Add the machine printer Host name to the etc/hosts file on the SCO workstation.
2. Ensure that you can ping the machine from the SCO workstation. 

Perform the following steps to create a machine print queue on a SCO UNIX workstation using 
either the GUI or the TTY method.

GUI Method
1. Log in as root.
2. From the main desktop, select the icons System Administration: Printers: Printer Manager.
3. Select Printer: Add Remote: UNIX....
4. Enter the following information into the Add Remote UNIX Printer form:

a. Host: hostname.
Where hostname is the machine Host Name from the /etc/hosts file.

b. Printer: name of the queue being created.
For example: dc xxxq.

c. Select OK to complete the form.
5. Select OK in the Message window.
6. Select Host:Exit.
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7. Select File: Close this directory.
8. Select File: Close this directory.
9. Select Save in the Warning Confirmation window.
10. Enter Exit to log out of root account.
11. Open Unix Window.

tty Method
1. Enter su to access Super User mode.
2. Enter rlpconf to create a printer.
3. Enter the following information:

a. Printer Name: queuename
b. Remote Printer: r
c. Hostname: hostname
d. If the information has been entered correctly, enter y

4. Select Enter to accept the default for a non-SCO remote printer.
5. Select Enter to accept the default for non-default printer.
6. Select Enter to start the process for adding a queue.
7. Enter q to quit the rlconf program.

Linux CUPS

Static Addressing

Information Checklist

Before starting please ensure that the following item is available and/or the task has been performed:
• Linux operating system that supports printtool.

Procedure

Follow the steps in Configure Static IPv4 Addressing using the Machine User Interface on page 28, 
then return to this page.

Create the Print Queue
1. Ensure that the Common UNIX Printing System (CUPS) is installed and started on your client.

The latest version of CUPS is available at cups.org.
2. Open the web browser from your workstation.
3. For example, enter http://127.0.0.1:631/printers in the Address Bar.
4. Press Enter.
5. Select Add Printer.
6. The Authorization dialog box will appear. 
7. Enter the root and the root password.
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8. In the Add New Printer screen enter a name for the printer.
9. Enter a location and description for the printer (optional).
10. Select Continue.
11. In the Machine menu, select Internet Printing Protocol.
12. Select Continue.
13. Enter ipp://hostname/ipp/printername.

Where hostname is the hostname of the Xerox machine and printername is the printer name of 
the Xerox machine.

14. Select Continue.
15. Select Xerox in the Make menu.
16. Select Continue.
17. Select the correct driver in the Driver menu.
18. Select Continue.
19. The Printer Added Successfully message will appear.

Dynamic Addressing

Procedure

Follow the steps in Configure Dynamic IPv4 Addressing using the Machine User Interface on page 29, 
then return to this page.

IMPORTANT: Highlight BOOTP in step 6.

Create the Print Queue

Follow the steps to Create the Print Queue on page 37.

Linux LPR via PrintTool

Static Addressing

Information Checklist

Before starting please ensure that the following item is available and/or the task has been performed:
• Linux operating system that supports PrintTool.

Procedure
1. Follow the steps in Configure Static IPv4 Addressing using the Machine User Interface on page 28, 

then return to this page.

Create the Print Queue
2. Log in, at the Linux Client, as root in a terminal.
3. Enter printtool.
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4. The Red Hat Linux Print System Manager will launch.
5. Select Add.
6. The Add a Printer Entry window will appear.
7. Select Remote Unix (lpd) Queue.
8. Select OK.
9. The Edit Remote Unix (lpd) Queue Entry window will appear. 
10. Enter the name of your Print Queue in the Names area.
11. The Spool directory is the directory where print jobs are stored and is a subdirectory of 

/var/spool/lpd. Add the name of the print queue to the end of the subdirectory path.
12. Ensure that the File Limit reads 0.
13. In the Remote Host area, enter the IP Address of the Xerox machine.
14. In the Remote Queue area, enter the Print Queue Name from step 9.
15. DO NOT select the Input Filter option.
16. Leave the default Suppress Headers selected. 
17. Select OK.
18. The printer should now be listed in the Red Hat Linux Print System Manager window. Select the 

lpd menu.
19. Select Restart lpd.
20. Select the PrintTool menu.
21. Select Exit to close the program.
22. To allow access to the printer, edit the /etc/hosts table to list the client system.
23. Edit and create the /etc/hosts.lpd file to list the client system.

Dynamic Addressing

Procedure

Follow the steps in Configure Dynamic IPv4 Addressing using the Machine User Interface on page 29, 
then return to this page.

IMPORTANT: Highlight BOOTP in step 6.

Create the Print Queue

Follow the steps to Create the Print Queue on page 37.

Linux LPRng

Static Addressing

Information Checklist

Before starting please ensure that the following item is available and/or the task has been performed:
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• Linux operating system that supports PrintTool. 

Procedure

Follow the steps in Configure Static IPv4 Addressing using the Machine User Interface on page 28, 
then return to this page.

Create the Print Queue
1. Open the LPRngTool from the Linux Client.
2. Select Add.
3. In the Names area, enter a name for your print queue.
4. The spool directory is the directory where print jobs are stored and is a subdirectory of 

/var/spool/lpd. Add the name of the print queue to the end of the subdirectory path.
5. In the Hostname/IP of Printer area, enter the hostname or IP Address of the Xerox machine.
6. Select OK.
7. Select Exit to close the program.
8. To allow access to the printer, edit the /etc/hosts table to list the client system.
9. Edit and create the /etc/hosts.lpd file to list the client system.

Dynamic Addressing

Procedure

Follow the steps in Configure Dynamic IPv4 Addressing using the Machine User Interface on page 29, 
then return to this page.

IMPORTANT: Highlight BOOTP in step 6.
• Follow the steps to Create the Print Queue on page 37.
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4Printer Drivers

This chapter explains how to install the printer drivers on your computer and covers the following 
topics:
• Overview on page 42
• Windows - Installing Driver on page 43
• Macintosh - Installing Driver on page 45
• Linux - Installing Drivers on page 47
• Unix - Installing Drivers on page 49
• Sharing your Machine Locally on page 51
• Windows Printing on page 53
• Configure the Windows Printer Driver on page 60
• Apple Mac on page 62
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Overview
Overview

The Software and Documentation CD is supplied with your machine. The machine supports the 
following operating systems:
• Windows

• Windows 2000
• Windows XP
• Windows Server 2003
• Windows Vista
• Windows Server 2008
• Windows 7
• Windows 2008 Server R2 

• Macintosh
• Mac OS X 10.3 ~ 10.4
• Mac OS X 10.5
• Mac OS X 10.6

• Linux
• Unix
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Windows - Installing Driver

You can install the printer software using the typical or the custom method.

The steps below are recommended for most users who use a machine that is directly connected to a 
workstation. All components necessary for machine operation will be installed.

Information Checklist

Before starting, please ensure that the following items are available and/or the tasks have been 
performed:
• Make sure that the machine is connected to your computer and powered on. 
• If the New Hardware Wizard window appears during the installation procedure, select in the 

upper right corner of the box to close the window, or select Cancel.

Procedure

1. Insert the supplied Software and Documentation CD into your CD-ROM drive.
The Software and Documentation CD runs automatically and the installation window displays.
a. If the installation window does not appear:

• Select Start and then Run. 
• Type X:\Setup.exe, replacing “X” with the letter which represents your drive. Select OK.
• If you use Windows Vista, Windows 7 or Windows 2008 Server R2 select Start >All 

programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents your drive and select 
OK.

b. If the AutoPlay window appears in Windows Vista, Windows 7 or Windows 2008 Server R2, 
select Run Setup.exe in the Install or run program field.

c.  In the User Account Control window, select Continue or Yes.
2. If necessary, from the Select a language from the list below drop-down menu, select a preferred 

language and select Next.
3. In the Select Installation Type window, select Typical installation for a network printer and 

select Next. The program will search the network for your machine.

Note If your machine is not already connected to the computer, the Connect Device window will 
appear.

• Select the Printer Port for your machine.
• Select your machine in the Printer Name list and click Next.
• The program will install the printer driver files. The Setup Completed message displays 

with the I’d like to print a test page checkbox. If you choose to print a test page, select 
the checkbox. 

• Select Finish. 
4. Verify the test page prints at your machine.
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If the Printer Driver does not Work

If the printer driver does not work properly, uninstall the driver and reinstall it. 

For windows follow the steps below to uninstall the driver.

1. Make sure that the machine is connected to your computer and powered on.
2. From the Start menu, select Programs or All Programs > Xerox Printers > your printer driver 

name > Maintenance.
3. Select Remove and select Next.

You will see a component list so that you can remove any item individually.
4. Select the components you want to remove and then select Next.
5. When your computer asks you to confirm your selection, select Yes.

The selected driver and all of its components are removed from your computer.
6. After the software is removed, select Finish. 

If you want to reinstall the driver over the currently installed driver via the provided Software and 
Documentation CD, insert the CD; the window with an overwriting confirmation message appears. 
Simply confirm it to proceed to the next step. Next steps are same as the first installation you have 
made.

Also, it provides you with the TWAIN driver for scanning on a Macintosh computer.

Wireless Setup (WorkCentre 3325DNI)
Note The machine will not connect to the wireless network while the network cable is attached. 

1. Ensure your printer is powered on. 
2. Insert the supplied Software and Documentation CD into your CD-ROM drive.

The CD should run automatically and the installation window appear.
• If the installation window does not appear, select the Start button and then Run. Type 

X:\Setup.exe, replacing “X” with the letter which represents your drive and select OK.
• If you use Windows Vista, select Start > All programs > Accessories > Run, and type 

X:\Setup.exe. If the AutoPlay window appears in Windows Vista, select Run Setup.exe in the 
Install or run program field, and select Continue in the User Account Control window.

3. Select Install Software.
4. Select Wireless Setup and follow the wizard instruction to select and install the printer.

If your printer is not already connected to the computer, the Connect Device screen will appear. 
After connecting the printer, select Next and follow the wizard instruction to install the printer.

5. After the installation is finished, select Finish. If your printer is connected to the network, a Test 
Print page will be printed. 
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Macintosh - Installing Driver

The Software and Documentation CD that came with your machine provides you with the Driver files 
that allows you to use the CUPS driver or PostScript driver (only available when you use a machine 
which supports the PostScript driver) for printing on a Macintosh computer.

Also, it provides you with the TWAIN driver for scanning on a Macintosh computer.

Information Checklist

Before starting please ensure that the following item is available and/or the task has been performed:
• Make sure that the machine is connected to your computer and powered on.

Procedure

1. Insert the supplied Software and Documentation CD into your CD-ROM drive.
2. Select the CD-ROM icon that appears on your Macintosh desktop.
3. Select the MAC_Installer folder.
4. Select the Installer icon.
5. Enter the password and select OK.
6. The Xerox Installer window opens. Select Continue.
7. Select Easy Install and select Install.

Easy Install is recommended for most users. All components necessary for machine operations 
will be installed. 
If you select Custom Install, you can choose individual components to install.

8. When the message which warns that all applications will close on your computer appears, select 
Continue.

9. After the installation is finished, select Quit. 

Note If you have installed the scan driver, select Restart.

10. Open the Applications folder > Utilities > Print Setup Utility.
• For Mac OS X 10.5~10.6, open the Applications folder > System Preferences and select 

Print & Fax.
11. Select Add on the Printer List.

• For Mac OS X 10.5~10.6, press the “+” icon; a display window will pop up. 
12. For Mac OS X 10.3, select the USB tab. 

• For Mac OS X10.4, select Default Browser and find the USB connection.
• For Mac OS X 10.5~10.6, select Default and find the USB connection.

13. For Mac OS X 10.3, if Auto Select does not work properly, select Xerox in Printer Model and your 
machine name in Model Name.

• For Mac OS X 10.4, if Auto Select does not work properly, select Xerox in Print Using 
and your machine name in Model.
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• For Mac OS X 10.5~10.6, if Auto Select does not work properly, select Select a driver to 
use... and your machine name in Print Using. 

Your machine appears and is set as the default machine.
14. Select Add. 

If the printer driver does not work properly uninstall the driver and reinstall it. Follow the steps below to 
uninstall the driver for Macintosh.

1. Make sure that the machine is connected to your computer and powered on.
2. Insert the supplied Software and Documentation CD into your CD-ROM drive.
3. Select the CD-ROM icon that appears on your Macintosh desktop.
4. Select the MAC_Installer folder.
5. Select the Installer icon.
6. Enter the password and select OK.
7. The Xerox Installer window opens. Select Continue.
8. Select Uninstall and click Uninstall. 
9. When the message which warns that all applications will close on your computer appears, select 

Continue.
10. When the uninstall is done, select Quit.
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Linux - Installing Drivers

You need to download the Linux software package from the Xerox website to install the printer 
software.

Procedure for Installing the Linux Unified Driver

1. Make sure that the machine is connected to your computer and powered on.
You must log in as a super user (root) to install the machine software. If you are not a super user, 
ask your system administrator. 

2. When the Administrator Login window appears, type in root in the Login field and enter the 
system password. 

3. From the Xerox website, download the Unified Linux Driver package to your computer.
4. Select the Unified Linux Driver package and extract the package.
5. Select cdroot > autorun.
6. When the Welcome screen appears, select Next.
7. When the installation is complete, select Finish.

The installation program has added the Unified Driver Configuration desktop icon and the Unified 
Driver group to the system menu for your convenience. If you have any difficulties, consult the on-
screen help that is available through your system menu or called from the driver package Windows 
applications, such as Unified Driver Configurator or Image Manager.

Installing the SmartPanel

1. Make sure that the machine is connected to your computer and powered on.
2. When the Administrator Login window appears, type in root in the Login field and enter the 

system password. 

Note You must log in as a super user (root) to install the machine software. If you are not a super 
user, ask your system administrator. 

3. From the Xerox website, download the Smart Panel package to your computer. 
4. Select the Smart Panel package and extract the package. 
5. Select cdroot > Linux > smartpanel > install.sh.

Installing the Printer Setting Utility

1. Make sure that the machine is connected to your computer and powered on. 
2. When the Administrator Login window appears, type in root in the Login field and enter the 

system password. 

Note You must log in as a super user (root) to install the machine software. If you are not a super 
user, ask your system administrator. 

3. From the Xerox website, download the Printer Setting Utility package to your computer. 
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4. Select the Printer Setting Utility package and extract the package. 
5. Select cdroot > Linux > psu > install.sh. 

If the Printer Driver does not Work Properly uninstall the driver and reinstall it. Follow the steps below to 
uninstall the driver for Linux.

1. Make sure that the machine is connected to your computer and powered on.
2. When the Administrator Login window appears, type in root in the Login field and enter the 

system password.
You must log in as a super user (root) to uninstall the printer driver. If you are not a super user, ask 
your system administrator.

3. Select the icon at the bottom of the desktop. When the Terminal screen appears, type in:
root@localhost root#cd /opt/Xerox/mfp/uninstall/
root@localhost uninstall#./uninstall.sh

4. Select Uninstall.
5. Select Next. 
6. Select Finish.
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Unix - Installing Drivers

Unix printer drivers are located on the Software and Documentation CD delivered with your machine. 
To use the Unix printer driver, you need to install the Unix printer driver package first, then set up the 
printer. The installation procedure is common for all variants of Unix OS mentioned.

Procedure for Installing the Unix Driver Package

1. Make sure that the machine is connected to your computer and powered on.
2. Acquire root privileges.

su -
3. Copy the appropriate driver archive to the target Unix computer.
4. Unpack the Unix printer driver package name.

For example, on IBM AIX, use the following command:
gzip -d < “package archive name” | tar xf -
The “binaries” folder consists of binz, install, share files and folders.

5. Change to the driver’s “binaries” directory.
For example, on IBM AIX, 
cd aix_power/binaries

6. Run the install script.
./install
Install is the installer script file which is used to install or uninstall the Unix Printer Driver package. 
Use “chmod 755 install” command to give the permission to the installer script. 

7. Execute the “./install-c” command to verify installation results.
8. Run “installprinter” from the command line. This will bring up the Add Printer Wizard window. 

Follow the procedures in Setting up the printer on page 49 to setup the printer.

Note On some Unix OS, for example on Solaris 10, printers recently installed may not be enabled 
and/or may not accept jobs. In this case run the following two commands on the root terminal:

accept <printer_name>
enable <printer_name>

Setting up the printer

To add the printer to your Unix system, run “installprinter” from the command line. This will bring up 
the Add Printer Wizard window. Setup the printer in this window according to the following steps.

1. Type the name of the printer.
2. Select the appropriate printer model from the model list.
3. Enter any description corresponding to the type of printer in the Type field. This is optional.
4. Specify any printer description in the Description field. This is optional. 
5. Specify the printer location in the Location field. 
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6. Type the IP address or DNS name of the printer in the Device textbox for network connected 
printers. On IBM AIX with jetdirect Queue type, only the DNS name is possible. It is not possible 
to enter a numeric IP address. 

7. Queue type shows the connection as lpd or jetdirect in the corresponding list box. Additionally 
usb type is available on Sun Solaris OS. 

8. Select Copies to set the number of copies. 
9. Check the Collate option to receive copies already sorted.
10. Check the Reverse Order option to receive copies in the reverse order.
11. Check the Make Default option to set this printer as default.
12. Click OK to add the printer. 

Uninstalling the printer driver package
Note The utility should be used if you need to delete a printer installed on the system.

1. Run the “uninstallprinter” command from the terminal. It wil open the Uninstall Printer Wizard. 
The installed printers are listed in the drop-down list.

2. Select the printer to be deleted.
3. Click Delete to delete the printer from the system.
4. Execute the “./install-d” command to uninstall the whole package. 
5. To verify removal results, execute the “./install-c” command.
6. To re-install it, use the command “./install” to reinstall the binaries. 
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Sharing your Machine Locally

If a Host computer is directly connected to the machine with a USB cable and is also connected to the 
local network environment, the client computer connected to the local network can use the shared 
machine through the host computer to print.

Follow the steps below to set up the computers to share your machine locally.

Windows

Host Computer Setup

1. Install your printer driver. Refer to Windows - Installing Driver on page 43.
2. From the Windows Start menu:

• For Windows 2000, select Settings > Printers.
• For Windows XP/2003, select Printers and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and Sound > Printers.
• For Windows 7, select Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware > Devices and Printers.

3. Select your printer icon.
• For Windows XP/2003/2008/Vista/7, select Printer Properties.
• For Windows Server 2008 R2, from the Context menus, select the Printer properties.

Note If the Printer properties item has ?, you can select other printer drivers connected with the 
selected printer.

4. Select the Sharing tab.
5. Check the Change Sharing Options checkbox.
6. Check the Share this printer checkbox.
7. Enter details in the Share Name field.
8. Select OK or Next.

Client Computer Setup

1. Install your printer driver. Refer to Windows - Installing Driver on page 43.
2. From the Windows Start menu select All programs > Accessories > Windows Explorer.
3. Enter the IP address of the host computer and press Enter.
4. If the host computer requires a User name and Password, enter details in the User ID and 

password field of the host computer account.
5. Select the printer icon you want to share and select Connect.

If a set up complete message appears, select OK. 
6. Open the file you want to print and start printing. 
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Macintosh

The following steps are for Mac OS X 10.5~10.6. Refer to Mac Help for other OS versions.

Host Computer Setup

1. Install your printer driver. Refer to Macintosh - Installing Driver on page 45.
2. Open the Applications folder > System Preferences and select Print & Fax. 
3. Select the printer to share in the Printers list. 
4. Select “Share this printer”.

Client Computer Setup

1. Install your printer driver. Refer to Macintosh - Installing Driver on page 45.
2. Open the Applications folder, select System Preferences and select Print & Fax. 
3. Press the “+” icon. 

A display window showing the name of your shared printer appears.
4. Select your machine and select Add. 
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Windows Printing

LPR Printing

Ensure Print Services for Unix is enabled

Follow the relevant steps below that are specific to your operating system:

Windows XP

1. From your workstation, load the Software and Documentation CD into your CD drive. If the CD 
autoruns, select Exit.

2. Verify that Print Services for Unix is loaded.
3. Select Start.
4. Select Control Panel.
5. Select Add or Remove Programs.
6. Select Add/Remove Windows Components in the left hand column.
7. Scroll down to Other Network File and Print Services and check on the checkbox to select it.
8. Select Details.
9. If it is not selected, check on the Print Services for Unix checkbox.
10. Select the OK button.
11. Select the Next button.

If Print Services for Unix is not installed, refer to instructions from Microsoft to install this service. 
When you are finished, return to this page.

12. Select the Finish button.

Windows 2000/2003

1. From the desktop, select the My Network Places icon and select Properties. 
2. Select the Local Area Connection icon and select Properties.
3. Verify that the Internet Protocol (TCP/IP) protocol has been loaded. If this software is not 

present, install it using the documentation provided by Microsoft. When you are finished, return to 
this page.

4. Verify that Print Services for Unix is loaded: 
a. Select Start, Settings then Control Panel.
b. Select the Add/Remove Programs icon.
c. Select Add/Remove Win Components in the far left column.
d. Select Other Network File and Print Services.
e. Select Details.
f. Check the Print Services for Unix checkbox. If Print Services for Unix is not installed, refer to 

instructions from Microsoft to install this service. When you are finished, return to this page.
5. Select the OK button.
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6. Select the Next button.
7. Select the Finish button.
8. Close the Add/Remove Programs window.

Windows Vista

1. Select Start > Control Panel > Program and select Programs and Features.
2. Select Turn Windows Features on and off.
3. In the Windows Features window, expand the Print Services menu.
4. Check the LPR Port Monitor checkbox to enable the service.
5. Select the OK button. Your computer may need to restart.

Windows 7

1. Select Start, select Control Panel.
2. Select Hardware and Sound, select Programs.
3. Select Programs and Features.
4. Select Turn Windows Features on and off from the menu on the left.
5. A Windows Features dialog displays. Select the ‘+’ sign for Printer and Document Services.
6. Check the box for LPR Port Monitor to enable the service.
7. Select the OK button. Your computer may need to restart.

Windows 2008

1. Select Start, select Administrative Tools.
2. Select Print Management.
3. Select the ‘+’ sign for Print Servers. Select the print server to which you want to add the printer 

and select Add Printer.
4. Check the box for LPR Port Monitor to enable the service.
5. Select the OK button. Your computer may need to restart.

Install Printer Driver

1. From the Windows Start menu
• For Windows 2000/2003 - select Settings then Printers.
• For Windows XP - select Printers and Faxes. If you cannot see this option in the Start 

menu, then select Start, followed by Control Panel first.
• For Windows Vista - select Control Panel then Printers.
• For Windows 7 - select Hardware and Sound then select Devices and Printers.
• For Windows 2008 - select Control Panel then select Printers. From the File drop-down 

menu select Run as administrator.
2. For:

Windows XP/2000/2003:
a. Select Add Printer in the far left column.
b. Select the Next button.
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Windows Vista:
a. Select Add Printer.
Windows 7:
a. Select Add a Printer.
Windows 2008:
a. Select Add Printer.

3. For:
• Windows 2000 - select Local Printer.
• Windows XP/2003/2008 - select Local Printer attached to this computer.

If already selected, select Automatically detect and install my Plug and Play printer to deselect 
it.

• Windows Vista - select A printer attached to my computer.
• Windows 7 - select Add a Local Printer.

4. Select the Next button.
5. Select Create a new port.
6. Select the following option from the Type of Port pull down menu:

• For Windows 2000/2003 select LPR.
• For Windows XP/Vista/7 select LPR Port.

7. Select the Next button.
8. Enter the IP Address of the printer.
9. Enter details in:

• Printer name for Windows XP/2000/2003/2008.
• Print Queue name for Windows Vista.
• Port name for Windows 7.

10. Select the OK button.
11. You will be prompted for a Printer Driver. Select Have Disk.
12. Select the Browse button. 
13. Locate the Drivers folder on the CD and select the required Printer Driver file .inf.
14. Select the Open button.
15. Select the OK button.
16. Select the Printer Model from the list.
17. Select the Next button.
18. The Name your Printer screen appears.
19. To configure the settings:

a. Enter details in the Printer Name field.
b. If you want to set this printer as your default printer, select Set as default. For Windows Vista 

users, go to step 25.
20. Select the Next button.
21. The Printer Sharing Screen appears.

If you will be sharing this printer with other clients, then:
a. Select:
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• Share As: - for Windows 2000.
• Share Name - for Windows XP/2003/Vista/7.

b. Enter details in the Share Name field.
22. Select the Next button.
23. Enter a Location name and Comment if required.
24. Select the Next button.
25. Select Yes or Print Test Page to print a test page.
26. Select the Next button to close the Test Page window.
27. Select the Finish button. The printer driver will install.
28. Verify that the test page is printed at the machine.

Internet Printing Protocol (IPP) Port

The Internet Printing Protocol (IPP) defines a standard protocol for printing as well as managing print 
jobs, media size, resolution, and so forth. IPP can be used locally or over the Internet, and also supports 
access control, authentication, and encryption, making it a much more capable and secure printing 
solution than older ones.

Note IPP Printing is enabled by default.

How to Enable the IPP Port

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Select Properties.
3. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
4. In the Network Settings link select Raw TCP/IP, LPR, IPP in the directory tree.
5. In the Internet Printing Protocol (IPP) area:

a. For IPP Protocol, select Enable from the drop-down menu. The Printer URI displays the 
http:// IP address of the machine and the ipp:// IP address of the machine. Enter the required 
printer name in the Printer Name area.

b. Select the Advanced button. Enter the required information for IPP Attribute. Select the IPP 
Security tab. From Authentication Type drop-down menu, select one of the following types 
of authentication scheme to use when printing with IPP. These schemes are only used if the 
printer has both a user name and password entered for IPP:
• None
• Basic - this scheme requires the printer to authenticate the person sending the print job. 

The printer only services the request if the name and password provided by the user 
match the values stored in the printer.

• Digest - this scheme requires the printer to authenticate the person sending the print job 
using a single checksum password scheme. The printer only services the request if the 
name and password provided by the user match the values stored in the printer.

c. If you have selected Basic or Digest, select the Add button. Enter the user name for the 
printer in the User Name field.
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d. Enter the password in the Password and Confirm Password fields.
6. Select Apply to save the changes.

Install Printer Driver

1. Follow the steps below that are specific to your operating system:
Windows XP
From your workstation:
a. Select Start.
b. Select Network Connections.
Windows 2000/2003
From your workstation:
a. Select the My Network Places icon.
b. Select Properties. 
Windows 7
From your workstation:
a. Select Start.
b. Select Network and Internet.
c. Select Network and Sharing Centre. Go to step 4.
Windows 2008
From your workstation:
a. Select Start, select Control Panel.
b. Select Printers.
c. Select File, select Run as administrator. Go to step 6.

2. Select the Local Area Connection icon.
3. Select Properties.
4. Ensure that the Internet Protocol (TCP/IP) protocol has been loaded and ensure the checkbox is 

checked.
5. For:

• Windows 2000/2003 - select Settings then Printers.
• Windows XP - select Printers and Faxes. If you cannot see this option in the Start menu, 

then select Start, followed by Control Panel first.
• Windows Vista - select Add a Local Printer.
• Windows 7 - select Start, select Control Panel, select Hardware and Sound, then 

Devices and Printers.
6. Select Add Printer in the far left column.

For Windows 7 select Add a network, wireless or Bluetooth printer.
7. The Add Printer Wizard window will appear. Select the Next button.
8. In the Local or Network Printer, ensure that A network printer, or a printer attached to another 

computer is selected and select the Next button. 
9. The following screen will appear:

• Locate Your Printer for Windows 2000/2003.
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• Specify a Printer for Windows XP.
10. To create an IPP printer, select Connect to a printer on the Internet....
11. Type HTTP:// followed by the printer's fully qualified Domain name or IP Address in the URL field. 

The Printer Name can be either the Host Name or the SMB Host Name as shown on the machine 
Configuration Report, depending on the name resolution used by your network (WINS or DNS).

12. Select the Next button.
13. Select the OK button to install the printer driver.
14. Select the Have Disk button and browse to the location of the printer driver and select the OK 

button.
15. Select the Printer Model and Select the OK button.
16. Select Yes if you wish to make this the default printer.
17. Select the Next button.
18. Select the Finish button.

Raw TCP/IP Printing (Port 9100)

Raw TCP/IP is a printing protocol that is similar to LPR printing. Also known as a direct TCP/IP 
connection or sockets interface, it sends information directly to the machine and does not require a 
Line Printer Daemon (LPD). The advantages are that connections stay open for multiple print files and 
spooling is not needed, therefore, printing is faster and more reliable than LPD printing. Raw TCP/IP 
printing is contained in Windows 2000 and other third-party applications and operating systems.

Note Raw TCP/IP Printing is enabled by default for port 9100.

Information Checklist

See the Information Checklist in Configure Static IPv4 Addressing using the Machine User Interface on 
page 28.

How to Configure Port 9100

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Select Properties.
3. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
4. In the Network Settings link select Raw TCP/IP, LPR, IPP in the directory tree.
5. In the Raw TCP/IP Printing area:

a. Select Enable.
b. For Port Number, enter the required port number (1 - 65535).

6. Select Apply to save the changes or Undo to return the settings to their previous values.

Note The settings are not applied until you restart the machine.

Install Printer Driver

Refer to Windows - Installing Driver on page 43.
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USB Printing

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• A standard USB peripheral cable.
• A workstation or laptop that supports USB connectivity.

Procedure

1. Connect the USB cable from your computer to the USB port at the back of the machine.
2. Insert the supplied Software and Documentation CD into your CD-ROM drive.

The Software and Documentation CD runs automatically and the installation window displays.
a. If the installation window does not appear:

• Select Start and then Run. 
• Type X:\Setup.exe, replacing “X” with the letter which represents your drive. Select OK.
• If you use Windows Vista, Windows 7 or Windows 2008 Server R2 select Start >All 

programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents your drive and select 
OK.

b. If the AutoPlay window appears in Windows Vista, Windows 7 or Windows 2008 Server R2, 
select Run Setup.exe in the Install or run program field.

c.  In the User Account Control window, select Continue or Yes.
3. If necessary, from the Select a language from the list below drop-down menu, select a preferred 

language and select Next.
4. In the Select Installation Type window, select Typical installation for a local printer and select 

Next. The program will search the network for your machine.
• Select your machine in the Printer Name list and click Next.
• The program will install the printer driver files. The Setup Completed message displays 

with the I’d like to print a test page checkbox. If you choose to print a test page, select 
the checkbox. 

• Select Finish. 
5. Verify the test page prints at your machine.
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Configure the Windows Printer Driver

Manual Print Driver Configuration

To configure the printer driver without using Bi-Directional communication:

Follow the steps below that are specific to your operating system:

1. Select the Windows Start menu.
2. Select one of the following for your Operating System:
3. For:

• Windows 2000, select Settings > Printers.
• Windows XP/2003, select Printers and Faxes.
• Windows 2008/Vista, select Control Panel > Hardware and Sound > Printers.
• Windows 7, select Control Panel > Hardware and Sound > Devices and Printers.
• Windows Server 2008 R2, select Control Panel > Hardware > Devices and Printers.
• Windows 7 and Server 2008 R2, from context menus, select the Printer properties.

4. Select the printer icon and then select Preference.
For Windows XP/2003/2008/Vista, select Preference.

5. Select each tab and change any default printer settings as required.
6. Select Apply.
7. Select OK.

For further printing options refer to the WorkCentre 3315DN/3325DN/3325DNI User Guide.

Bi-Directional Support

Follow the steps below that are specific to your operating system:

1. Select the Windows Start menu.
2. Select one of the following for your Operating System:
3. For:

• Windows 2000/2003, select Settings > Printers.
• Windows XP/2008, select Printers and Faxes.
• Windows Vista, select Control Panel > Hardware and Sound > Printers.
• Windows 7, select Control Panel > Hardware and Sound > Devices and Printers.
• Windows Server 2008 R2, select Control Panel > Hardware > Devices and Printers.

4. For Windows XP/2003/2008/Vista, select the printer icon and select Properties.
For Windows 7 select Printer Properties.

5. Select the Port tab.
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6. Check the Enable bidirectional support checkbox. 
Bi-directional communication automatically updates the printer driver with the printer's installed 
options. The driver’s Printing Preferences will report information about the printer's operational 
status, active jobs, completed jobs and paper status.

7. Select Apply, then OK.
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Apple Mac

TCP/IP Printing (OSX)

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• The TCP/IP settings must be correctly configured on the machine.
• Locate the Software and Documentation CD delivered with your machine.

Install the Print Driver

1. Load the Software and Documentation CD into your CD drive. 
2. Open the CD and select the required language, if necessary.
3. Select the Drivers folder.
4. Select the Mac folder.
5. Select the folder containing the drivers for your Mac OS version.
6. Select the machine model.dmg file.
7. Select the machine model.pkg file.
8. The Welcome to the Installer dialog box appears.
9. Select Continue.
10. Select Continue and then Agree to accept the License Agreement.
11. Select the Volume (if necessary) where you want to install the printer. Select Continue.
12. Select the Install button.
13. Select the Close button.
14. Select the Printer Setup Utility on the Dock.
15. Select the Hard Drive icon on the Desktop.
16. Select Applications.
17. Select Utilities.
18. Select Printer Setup Utility.
19. To add a new printer, select:

• Add. 
or

• Printers menu then Add Printer.
20. Select IP Printing from the top menu.
21. Select Internet Protocol Printing or LPD/LPR Printing from the next menu.
22. Enter the IP Address of the printer.
23. Enter the Print Queue Name. (You may leave this blank).
24. Select Xerox from the Printer Model list.
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25. Select your Printer Model from the list.
26. Select Add. The machine will appear in the Printer List.
27. Select the Printer and select Show Info.
28. Select Installable Options.
29. Select the options as installed on your machine. 

If you want to use the Save Job for Reprint feature, then make sure that Job Storage is set to 
Installed.

30. Select Apply Changes.
31. Close the Printer Info box.
32. Print a document to verify that the printer is installed correctly.

Configure your Apple Mac Print Driver

Information Checklist

Before starting please ensure that the following item is available and/or the task has been performed:
• The printer driver is installed on your Macintosh operating system.

Procedure - Changing Printer Settings

You can use advanced printing features provided by your machine.

Open an application and select Print from the File menu. The machine name, which appears in the 
printer properties window may differ depending on the machine in use. Except for the name, the 
composition of the printer properties window is similar to the following. 

Note The setting options may differ depending on printers and Macintosh OS version.

Layout

The Layout tab provides options to adjust how the document appears on the printed page. You can 
print multiple pages on one sheet of paper. Select Layout from the Orientation drop-down menu to 
access the following features:
• Pages per Sheet - this option determines how many pages are printed on one page. 
• Layout Direction - this option allows you to select the printing direction on a page similar to the 

examples on the display.
• Border - this option allows you to create a border around each page on the sheet.
• Two-Sided - this option allows you to print on both sides of the paper.
• Reverse Page Orientation - this option allows you to rotate the page180 degrees.

Graphics

The Graphics tab provides options for selecting Resolution. Select Graphics from the Orientation 
drop-down menu to access the graphic features:
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• Resolution - this option allows you to select the printing resolution. The higher the setting, the 
sharper the clarity of printed characters and graphics. The higher setting also may increase the 
time it takes to print a document.

Paper

Set Paper Type to correspond to the paper loaded in the tray from which you want to print. This will let 
you get the best quality printout. If you load a different type of print material, select the corresponding 
paper type.

Printer Features

The Printer Features tab provides Reverse Duplex Printing and Fit to Page options. Select Printer 
Features from the Orientation drop-down menu to access the following features:
• Reverse Duplex Printing - this option allows you to select general print order compared to duplex 

print order. If this option does not appear, your machine does not have this feature.
• Fit to Page - this option allows you to scale your print job to any selected paper size regardless of 

the document size. This can be useful when you want to check fine details on a small document.

Toner Save Mode

Selecting this option extends the life of your toner cartridge and reduces your cost per page without a 
significant reduction in print quality.

Printer Setting - select this option to allow toner settings to be determined by the setting you have 
made on the control panel of the printer.
• On - select this option to allow the printer to use less toner on each page.
• Off - if you do not need to save toner when printing a document, select this option.

Printing multiple pages on one sheet of paper

You can print more than one page on a single sheet of paper. This feature provides a cost-effective way 
to print draft pages.
• Select Layout from the Orientation drop-down menu. In the Pages per Sheet drop-down menu, 

select the number of pages you want to print on one sheet of paper.

Printing on both sides of paper

You can print on both sides of the paper. Before printing in the duplex mode, decide on which edge you 
will be binding your finished document. The binding options are, as follows:

• Long-Edge Binding - this option is the conventional layout used in book binding.
• Short-Edge Binding - this option is the type often used with calendars.

• Select Layout from the Orientation drop-down menu. Select a binding orientation from Two 
Sided Printing option.
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5Scan to Server 
(WorkCentre 
3325DN/3325DNI)

This chapter explains how to configure the machine to enable scanning to FTP or SMB servers.

Scan to Server enables users to convert their hard copy documents to electronic files and retrieve them 
from a server or workstation on the network.

For information on how to use the Scan to Server features, refer to the WorkCentre 
3315DN/3325DN/3325DNI User Guide delivered with your machine.

The following topics are covered in this chapter:
• Overview on page 66
• Configure Scan to FTP on page 67
• Configure Scan to SMB on page 70
• Configure Scan Security on page 72
• Enable Scan to Server on page 73
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Overview
Overview

The user scans a document at the machine and it is stored on a file server or workstation on the 
network. The user can manually retrieve their document from the file server or workstation, or an 
application can be used to retrieve the scanned documents automatically. 

The instructions on the following pages describe how to setup Scan to Server using Internet Services.

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Ensure that the machine is fully functioning on the network.
• TCP/IP and HTTP protocols must be enabled on the machine so that the machine’s web browser 

can be accessed.

Scan Transfer Methods

Scan to Server is accomplished through the use of a folder on a server or workstation, which the 
machine can access. When a user scans a document, the machine puts the image into the folder. To 
configure Scan to Server you must configure the machine with the path to the folder.

The machine can use two different ways to transfer a scanned image to the folder:
• FTP (File Transfer Protocol) - refer to Configure Scan to FTP on page 67.

This is used to scan to a computer that is configured with FTP services.
• SMB (Server Message Block) - refer to Configure Scan to SMB on page 70.

This is used to scan to a computer that supports the SMB protocol.
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Configure Scan to FTP

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Ensure that File Transfer Protocol (FTP) services are running on the server or workstation where 

images scanned by the machine will be stored.
Write down the IP Address or Host Name.

• Create a folder within the FTP root.
Write down the directory path structure.

• Create a User account and password which has read and write access to the folder within the FTP 
root. 
Write down the Login Name and Login Password details.

• Test the FTP connection by logging into the folder from a PC with the User account and password:
a. Create a new folder within the folder to check that the user account has appropriate access 

rights.
b. Delete the folder that you created.

Note If you cannot do the steps above, check the access rights for the user account.

Procedure

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Address Book icon.
4. Select Individual in the left hand menu. The Individual Address Book appears.
5. Select Add. The Add menu appears. 
6. Enter a name for your address book entry in the General area. 
7. Select the required Speed No. for this entry.
8. Scroll down to the FTP section. 
9. Select the Add FTP checkbox.
10. In the FTP Server Address area:

a. Enter the details of the FTP location in the FTP Server Address field.
b. Enter the FTP Server Port (default is 21).

Note It is recommended that the default port setting is used.

11. In the Login ID area:
a. Check the Anonymous checkbox to use an anonymous login.
b. If you require security, enter the FTP server login details in the Login ID field.
c. Enter the FTP server password in the Password and Confirm Password fields.
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d. Enter the directory path structure of the folder on your FTP server in the Path field.
12. In the Scan folder creating policy area select the required method for folder creation. The 

options are: 
• Create new folder using login name.
• Create new folder every Day, Month, Year.
• Create new folder only if scan output consists of several files.

13. Select the required Filing Policy from the drop down menu.
14. Enter the required File Name for your scanned documents.
15. Select Apply to save the changes. 

Configure Scan to FTP Server Default Settings

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the Scan link.
6. Select Change Default.
7. In the Scan to FTP area:

a. From the Original Type drop-down menu, select one of the following options to define the 
content type being scanned:
• Text
• Text/Photo
• Photo

b. From the Resolution drop-down menu, select one of the following resolutions for the content 
being scanned:
• 100 dpi
• 200 dpi
• 300 dpi

c. From the Output Scan Color drop-down menu, select one of the following options:
• Color
• Black and White
• Grayscale

d. From the File Format drop-down menu, select one of the following formats for scanned 
image:
• Single-Page TIFF
• Multi-Page TIFF
• PDF
• JPEG (only available when Color or Grayscale is selected)

8. Select the required settings for Lighten/Darken and Contrast.
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9. Select Apply to save the changes.
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Configure Scan to SMB

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Create a shared folder to be used as a Scan to Server location for scanned documents.

Write down the name of the Share folder, the IP Address or Hostname and the Domain. 
• Create a User account and password for the machine to have read/write access to the scan 

directory. 
Write down the User Account and Password details.

• Test your settings by logging in to the scan directory from a PC with the user account and 
password:
a. Create a new folder within the directory to check that the user account has appropriate 

access rights.
b. Delete the folder. 

Note If you cannot do the steps above, check the access rights for the user account.

Procedure

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Address Book icon.
4. Select Individual in the left hand menu. The Individual Address Book appears.
5. Select Add. The Add menu appears. 
6. Enter a name for your address book entry in the General area. 
7. Select the required Speed No. for this entry.
8. Scroll down to the SMB section. 
9. Select the Add SMB checkbox.
10. In the SMB Server Address area:

a. Enter the details of the SMB location in the SMB Server Address field.
b. Enter the SMB Server Port (default is 139).

Note It is recommended that the default port setting is used.

11. In the Login ID area:
a. Check the Anonymous checkbox to use an anonymous login.
b. If you require security, enter the SMB server login details in the Login ID field.
c. Enter the SMB server password in the Password and Confirm Password fields.
d. Enter the Domain in the Domain field.
e. Enter the directory path structure of the folder on your SMB server in the Path field.
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12. In the Scan folder creating policy area:
a. Select the required method for folder creation. The options are: 

• Create new folder using login name.
• Create new folder every Day, Month, Year.
• Create new folder only if scan output consists of several files.

13. Select the required Filing Policy from the drop down menu.
14. Enter the required File Name for your scanned documents.
15. Select Apply to save the changes. 

Configure Scan to SMB Server Default Settings

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the Scan link.
6. Select Change Default.
7. In the Scan to SMB area:

a. From the Original Type drop-down menu, select one of the following options to define the 
content type being scanned:
• Text
• Text/Photo
• Photo

b. From the Resolution drop-down menu, select one of the following resolutions for the content 
being scanned:
• 100 dpi
• 200 dpi
• 300 dpi

c. From the Output Scan Color drop-down menu, select one of the following options:
• Color
• Black and White
• Grayscale

d. From the File Format drop-down menu, select one of the following formats for scanned 
image:
• Single-Page TIFF
• Multi-Page TIFF
• PDF
• JPEG (only available when Color or Grayscale is selected)

8. Select the required settings for Lighten/Darken and Contrast.
9. Select Apply to save the changes.
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Configure Scan Security

Scan Security allows you to enable the PC Scan Security option and select a digital signature for use 
with the Scan to Server feature. 

Note A Digital Certificate must be configured on the machine to use this feature. For instructions, 
refer to Machine Digital Certificate Management on page 116.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the Scan link.
6. Select the Scan Security link.
7. Select the Enable checkbox to enable PC Scan Security.
8. To select a certificate, click the Select Certificate button. 
9. Select the required certificate to use with the Scan to Server feature and click the Select button.
10. Select the Enable checkbox to enable a Digital Signature in PDF.
11. Select Apply to save the changes.
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Enable Scan to Server

The Internet Services Scan to Server page allows you to enable the Scan to FTP and Scan to SMB 
protocols required for the Scan to Server feature, and set the Server Connection Timeout. 

Note Scan to FTP and Scan to SMB protocols are enabled by default.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the Scan link. 
6. Select the Scan to Server link.
7. To enable Scan to FTP: 

a. Select the Enable checkbox next to FTP Protocol.
b. Enter the required Server Connection Timout (the default is 5 seconds).

8. To enable Scan to SMB: 
a. Select the Enable checkbox next to SMB Protocol.
b. Enter the required Server Connection Timout (the default is 5 seconds).

9. Select Apply to save the changes.
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6Scan to Network/Local 
PC

This chapter explains how to configure the Scan to Network and Scan to Local PC features. The 
following topics are covered:
• Overview on page 76
• Scan to Network PC on page 77
• Scan to Local PC on page 78
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Overview
Overview

The Scan to Network PC feature allows you to scan from your machine to a computer over the network. 
The Scan to Local PC feature allows you to scan from your machine to a computer connected with a 
USB cable.

Information Checklist

Ensure the Xerox Easy Printer Manager application is installed. For instructions refer to the Xerox 
WorkCentre 3315DN/3325DN/3325DNI Utilities Guide available on Xerox.com.

Note The Xerox Easy Printer Manager program can only be used in the Windows system.

Through the Xerox Easy Printer Manager, you can change scan settings and add or delete the folders 
where scanned documents are saved in your computer. 

Note To use the Scan to Local PC feature it is important to select Typical installation for a local 
printer when you install the Xerox Easy Printer Manager program.
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Scan to Network PC

1. Open the Xerox Easy Printer Manager application. Select Start, Programs or All Programs, Xerox 
Printers, Xerox Easy Printer Manager and select Easy Printer Manager.

2. Select the Switch to Advanced Mode button at the top of the window. 
3. Select your machine in the Printer List if required.
4. Select the Scan to PC Settings button. The Scan to PC Settings screen appears. 
5. Select Enable Scan from Device Panel. 
6. Select your required settings for Scan Settings:

• Image Type
• Resolution
• Scan Size
• ADF Duplex

7. Select your required settings for File Settings:
• Save To
• Format

8. Select the required option in the Actions after Saving area:
• Notify me when complete
• Open with Default Application
• E-mail 
• None

9. Select Save.
10. At the machine, load originals face up into the document feeder, or place a single original face 

down on the scanner glass.
11. At the control panel, press the Scan button. The Scan To: screen appears.
12. Press the Up/Down arrow buttons to highlight Network PC and select OK.
13. Enter the required Login ID and Password.
14. The Scan Destination screen displays, press the Up/Down arrow buttons until the setting you want 

highlights and press OK.
15. Retrieve your scanned document.
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Scan to Local PC
Scan to Local PC

This is a basic scanning method for USB connected machines.

1. Make sure that the machine is connected to your computer with a USB cable, and powered on.
2. Install the Xerox Easy Printer Manager application. For instructions refer to the Xerox WorkCentre 

3315DN/3325DN/3325DNI Utilities Guide available on Xerox.com.

Note To use the Scan to Local PC feature it is important to select Typical installation for a local 
printer when you install the Xerox Easy Printer Manager program.

3. Open the Xerox Easy Printer Manager application. Select Start, Programs or All Programs, Xerox 
Printers, Xerox Easy Printer Manager and select Easy Printer Manager.

4. Select the Switch to Advanced Mode button at the top of the window. 
5. Select your machine in the Printer List if required.
6. Select the Scan to PC Settings button. The Scan to PC Settings screen appears. 
7. Select Enable Scan from Device Panel. 
8. Select your required settings for Scan Settings:

• Image Type
• Resolution
• Scan Size
• ADF Duplex

9. Select your required settings for File Settings:
• Save To
• Format

10. Select the required option in the Actions after Saving area:
• Notify me when complete
• Open with Default Application
• E-mail 
• None

11. Select Save.
12. At the machine, load originals face up into the document feeder, or place a single original face 

down on the scanner glass.
13. At the control panel, press the Scan button. The Scan To: screen appears.
14. Press the Up/Down arrow buttons to highlight Local PC and select OK.
15. Enter the required Login ID and Password.
16. The Scan Destination screen displays, press the Up/Down arrow buttons until the setting you want 

highlights and press OK.
17. Retrieve your scanned document.
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7Fax

This chapter explains how to set up the Fax feature of the machine.

The following topics are covered in this chapter:
• Overview on page 80
• Enable Fax from the Machine on page 81
• Fax Address Book on page 84
• Fax Forward on page 85
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Overview
Overview

The Fax feature enables Users to send hard copy documents to another fax machine (or multiple fax 
machines) via a dedicated phone line connection. 

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Ensure that the machine is fully functioning in its existing configuration.
• Ensure that the machine has access to a telephone connection.
• Obtain the telephone number that you will configure as the machine's fax number.
• Connect your telephone cable(s) to the fax port(s) on the machine.
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Enable Fax from the Machine

1. Press the Machine Status button.
2. Press the Up/Down arrow buttons to highlight Fax Setup; press OK.
3. If prompted, enter the Administrator Password (1111).
4. Press the Up/Down arrow buttons to highlight Enable/Disable.
5. Press OK. The 1/3 Fax Phone Num. screen will appear. 
6. Enter the fax phone number and press OK. The 2/3 Fax ID screen appears. 
7. Enter the name for the fax and press OK. The Select Country screen appears. 
8. Select the required country and select OK. The Rebooting Machine screen appears. The machine 

will reboot.
9. The Saved screen will display and return to the Fax Setup menu. 

Test the Fax

1. At the Machine, press the Fax button on the control panel. 
2. Enter the number of a nearby fax machine using the alphanumerical keypad.
3. Place your documents in the document handler and press the Start button. 
4. Verify that your documents are received at the other fax machine.

Fax Defaults using Internet Services

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the Fax link.
6. Select the General link.
7. Ensure Fax is Enabled by selecting the checkbox.
8. In the Machine ID & Fax Number area:

a. Enter an ID in the Machine ID field.
b. Enter the fax number in the Fax Number field.

9. In the Change Default area:
a. From the Resolution drop-down menu select one of the following options:

• Standard - this method is best for standard office documents and images.
• Fine - this method produces a better image quality than Standard for documents and 

images.
• Superfine - this method is best for high quality images.
• Photo Fax - this method is best for photographic images.
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• Color Fax - this method is best for colored documents.
b. From the Lighten/Darken drop-down menu select one of the available options

• Lighten settings +1 to +5
• Normal (default)
• Darken settings +1 to +5

c. Select the required option for Contrast.
d. Check the Auto Report checkbox to enable automatic report.
e. From the Secure Receive drop-down menu select one of the following options to allow the 

machine to hold received faxes in the job queue as ‘Secure Receive’ fax jobs. The held faxes 
shall remain in the queue and will only be released from the queue when the user enters the 
release password:
• Off
• On - this option will require you to enter a Secure Receive passcode and click Apply
• Print fax in secure receive mode - this option is only available when On is selected from 

the Secure Receive menu. Select the Print button and enter the Secure Receive passcode. 
Click Apply.

10. In the Sending area:
a. From the Redial Times drop-down menu select the amount of times you want the machine 

to re-dial.
b. From the Redial Term drop-down menu select the minutes for the term of each redial.
c. If your telephone system requires you to enter a prefix in front of fax numbers, enter a prefix 

dial details in the Prefix Dial field.
d. Check the ECM Mode checkbox to enable Error Correction Mode.
e. From the Fax Send Report drop-down menu select one of the send report option.

• Off
• On - prints a report when a fax has been sent.
• On-Error - prints a report when an error occurs.

f. Check the Toll Save checkbox to allow users to send faxes during a low rate period.
If you have selected Toll Save, enter the start and end time of the Toll period in the following 
fields:
• Toll Save Start Time
• Toll Save End Time

11. In the Receiving area:
a. From the Receive Mode drop-down menu select the required option for the line:

• Tel - receives a fax by picking up the handset.
• Fax - answers an incoming fax call and immediately goes into the fax reception mode.
• Ans/Fax - select when an answering machine is attached to the machine. 

b. From the Ring to Answer drop-down menu select the number of time the machine should 
ring before answering.

c. Check the Stamp Receive Name checkbox to enable the machine to print a page number 
and the date and time of receipt on the bottom of each page of a received fax.
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d. Check the Receive Start Code checkbox to initiate fax reception from an extension phone 
plugged into the socket on the back of the machine. Select the required start code from the 
menu (the default is 9).

e. Check the Auto Reduction checkbox to automatically reduce large documents received to fit 
on the fax paper size of your machine.

f. In the Discard Size field, enter details of the fax size that can be discarded.

Note Discard Size is not available with Auto Reduction.

g. From the 2-Sided drop-down menu select one of the following options for printing on both 
sides of the page:
• Off
• Long Edge - prints on both sides along the long edges of the page.
• Short Edge - prints on both sides along the short edges of the page

12. Select Apply to save the changes.
13. Select OK when the acknowledgement message displays.

Adjusting Fax Document Settings at the Machine

Before starting a fax, change the settings for the Fax Options according to your original document to 
get the best quality.

1. Press the Fax button on the control panel.
2. Press the Menu button on the control panel. The Fax Features menu displays.
3. Press the Up/Down arrow buttons to highlight the feature required and press OK.
4. Press the Up/Down arrow buttons until the setting you want highlights and press OK.
5. When you have finished making your selections, press the Stop button to return to ready mode.

For further information on the options available, refer to the WorkCentre 3315DN/3325DN/3325DNI 
User Guide delivered with your machine.
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Fax Address Book

Refer to LDAP Configuration and Address Books on page 105.
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Fax Forward

Overview

This option allows incoming or outgoing faxes to be automatically forwarded to an anonymous fax 
recipient for auditing purposes.

You can choose to forward faxes to one of the following destinations:
• E-mail
• Server
• PC
• Fax

Fax Forward to E-mail

This option allows incoming or outgoing faxes to be forwarded to an E-mail recipient. Fax Forward to E-
mail can be configured using Internet Services or at the machine.

Procedure - Using Internet Services

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the Fax link.
6. Select the Fax Forward link.
7. In the General area: 

a. Select the required option from the Fax Forwarding menu.
b. Select the required option from the Print Confirmation Sheet menu.
c. From the Default Attachment Type menu select the attachment type.
d. Select Forward and Print if required. This feature allows the forwarded fax to be printed at 

the machine as a local copy.
8. In the Fax Forward To area, select E-mail. 

Note Fax Forward To is not available when you select Off from the Fax Forwarding menu.

9. In the Default From: Address: field enter the from e-mail address.
e. In the Recipient Address field, enter one or more e-mail addresses as required. Select the 

Load Address Book button to select an address from the local address book.
10. Select Apply to save the changes.
11. Select OK when the acknowledgement message displays.
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Procedure - At the Machine

Forwarding a sent fax to other destination by an e-mail

1. Press the Fax button on the control panel.
2. Press the Menu button on the control panel. The Fax Feature menu displays.
3. Press the Up/Down arrow buttons to highlight Forward and press OK.
4. Press the Up/Down arrow buttons to highlight E-mail and press OK.
5. Press the Up/Down arrow buttons to highlight Send Forward and press OK.
6. Press the Up/Down arrow buttons to highlight On and press OK.
7. The Enter From Address screen displays. Enter your e-mail address using the alphanumerical 

keypad and press OK.
8. The Enter To Address screen displays. Enter the e-mail address to where faxes are to be sent using 

the alphanumerical keypad and press OK.
9. The Another Address screen displays.

• To enter another address, press the Left/Right arrow button to highlight Yes and press 
OK. Repeat step 8.

• If another address is not required, press the Left/Right arrow button to highlight No and 
press OK.

10. The Saved screen displays and returns to the e-mail menu.
11. Press the Stop button to return to ready mode.

Subsequent sent faxes will be forwarded to the specified e-mail address or addresses.

Forwarding a received fax to other destination by an e-mail

1. Press the Fax button on the control panel.
2. Press the Menu button on the control panel. The Fax Feature menu displays.
3. Press the Up/Down arrow buttons to highlight Forward and press OK.
4. Press the Up/Down arrow buttons to highlight E-mail and press OK.
5. Press the Up/Down arrow buttons to highlight Receive Forward and press OK.
6. Press the Up/Down arrow buttons to highlight Forward and press OK.

To set the machine to print out a fax when fax forwarding has been completed, select Forward & 
Print. 

7. The Enter From Address screen displays. Enter your e-mail address using the alphanumerical 
keypad and press OK.

8. The Enter To Address screen displays. Enter the e-mail address to where faxes are to be sent using 
the alphanumerical keypad and press OK.

9. The Another Address screen displays.
• To enter another address, press the Left/Right arrow button to highlight Yes and press 

OK. Repeat step 8.
• If another address is not required, press the Left/Right arrow button to highlight No and 

press OK.
10. The Saved screen displays and returns to the e-mail menu.
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11. Press the Stop button to return to ready mode.
Subsequent received faxes will be forwarded to the specified e-mail address.

Fax Forward to Server

This option allows incoming or outgoing faxes to be forwarded to a folder on a FTP or SMB server. You 
can fax to a total of five servers. 

Note Forward to Server can be configured using either Internet Services or at the machine. 

Procedure - Using Internet Services

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the Fax link.
6. Select the Fax Forward link.
7. In the General area: 

a. Select the required option from the Fax Forwarding menu.
b. Select the required option from the Print Confirmation Sheet menu.
c. From the Default Attachment Type menu select the attachment type.
d. Select Forward and Print if required. This feature allows the forwarded fax to be printed at 

the machine as a local copy.
8. In the Fax Forward To area, select Server.

Note Fax Forward To is not available when you select Off from the Fax Forwarding menu.

9. Select Add.
10. In the General area:

a. Select the required Index number.
b. From the Protocol drop-down menu, select FTP or SMB.
c. Enter details of the setup in the Friendly Name field.
d. Select Load Address Book to add a destination already configured in the Address Book.

• Select the required destination in the Address Book list.
• Click Select.
• The address will populate the Server Address fields. 

11. The FTP or SMB settings will display depending on the selections made above. 
If you selected FTP in the protocol menu:
a. Enter the details of the server in the FTP Server address and Port fields. 
b. For Login Name select Anonymous - if anonymous login is required, or enter the Login Name 

for the server in the Login Name field.
c. Enter the Login Name password in the Password and Confirm Password fields.
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d. Enter the directory path structure of the folder on your FTP server in the Path field.
If you selected SMB in the protocol menu:
a. Enter the details of the server in the SMB Server address and Port fields. 
b. For Login Name select Anonymous - if anonymous login is required, or enter the Login Name 

for the server in the Login Name field.
c. Enter the Login Name password in the Password and Confirm Password fields.
d. Enter the Domain in the Domain field.
e. Enter the directory path structure of the folder on your SMB server in the Path field.

12. Select the required option for the Scan folder creating policy. The options are:
• Create new folder using login name
• Create new folder every: (options are Day, Month, Year)
• Create new folder only if scan output consists of several folders

13. Select Apply to save the changes.
14. Select OK when the acknowledgement message displays.

Procedure - At the Machine
Note Forward to Server can be configured using either Internet Services or at the machine. 

Forwarding a sent fax to other destination server

1. Press the Fax button on the control panel.
2. Press the Menu button on the control panel. The Fax Feature menu displays.
3. Press the Up/Down arrow buttons to highlight Forward and press OK.
4. Press the Up/Down arrow buttons to highlight Server and press OK.
5. Press the Up/Down arrow buttons to highlight Send Forward and press OK.
6. Press the Up/Down arrow buttons to highlight On and press OK.
7. Press the Stop button to return to ready mode.

Subsequent sent faxes will be forwarded to the specified server.

Forwarding a received fax to other destination server

1. Press the Fax button on the control panel.
2. Press the Menu button on the control panel. The Fax Feature menu displays.
3. Press the Up/Down arrow buttons to highlight Forward and press OK.
4. Press the Up/Down arrow buttons to highlight Server and press OK.
5. Press the Up/Down arrow buttons to highlight Receive Forward and press OK.
6. Press the Up/Down arrow buttons to highlight Forward and press OK.

To set the machine to print out a fax when fax forwarding has been completed, select Forward & 
Print. 

7. Press the Stop button to return to ready mode.
Subsequent received faxes will be forwarded to the specified server.
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Fax Forward to PC

This option allows incoming or outgoing faxes to be forwarded to a computer. Fax to PC is configured 
using Internet Services and the Xerox Easy Printer Manager application.

Information Checklist

Ensure the Xerox Easy Printer Manager application is installed. For instructions refer to the Xerox 
WorkCentre 3315DN/3325DN/3325DNI Utilities Guide available on Xerox.com.

Procedure

Enable Fax Forward to PC

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the Fax link.
6. Select the Fax Forward link.
7. In the General area: 

a. Select Received Faxes Only from the Fax Forwarding menu.
b. Select the required option from the Print Confirmation Sheet menu.
c. From the Default Attachment Type menu select the attachment type.
d. Select Forward and Print if required. This feature allows the forwarded fax to be printed at 

the machine as a local copy.
8. In the Fax Forward To area, select PC.

Note Fax Forward To PC is only available when you select Received Faxes Only from the Fax 
Forwarding menu.

9. Select Apply.

Configure Fax to PC

1. Open the Xerox Easy Printer Manager application. Select Start, Programs or All Programs, Xerox 
Printers, Xerox Easy Printer Manager and select Easy Printer Manager. 

2. Select the Switch to Advanced Mode button at the top of the Easy Printer Manager screen.
3. Select Fax to PC Settings.
4. Select Enable Fax Receiving from Device.
5. Select the required Image Type.
6. In the Save Location area the default path will appear where your fax documents will be stored. 

To change the location click the Search button and browse for a new location, or enter the path int 
the Save Location field.
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7. In the Prefix area:
a. Enter a Prefix for your fax documents.
b. Select the required format of the Prefix.

8. Select Print received fax if required.
9. Select the required Action after Fax received.
10. Select Save.

Fax Forward to Fax

This option allows incoming or outgoing faxes to be forwarded to another Fax machine.

Procedure - At the Machine

Forwarding a sent fax to another fax machine

1. Press the Fax button on the control panel.
2. Press the Menu button on the control panel. The Fax Feature menu displays.
3. Press the Up/Down arrow buttons to highlight Forward and press OK.
4. Press the Up/Down arrow buttons to highlight Fax and press OK.
5. Press the Up/Down arrow buttons to highlight Send Forward and press OK.
6. Press the Up/Down arrow buttons to highlight On and press OK.
7. Enter the destination fax number using alphanumerical keypad and press OK.
8. Press the Stop button to return to ready mode.

Subsequent received faxes will be forwarded to the specified server.

Forwarding a received fax to another fax machine

1. Press the Fax button on the control panel.
2. Press the Menu button on the control panel. The Fax Feature menu displays.
3. Press the Up/Down arrow buttons to highlight Forward and press OK.
4. Press the Up/Down arrow buttons to highlight Fax and press OK.
5. Press the Up/Down arrow buttons to highlight Receive Forward and press OK.
6. Press the Up/Down arrow buttons to highlight Forward and press OK.

To set the machine to print out a fax when fax forwarding has been completed, select Forward & 
Print. Enter the destination fax number using alphanumerical keypad and press OK.

7. Enter the destination fax number using alphanumerical keypad and press OK.
8. The Start Time screen displays. Enter the starting time using Up/Down/Left/Right arrow buttons 

or alphanumeric keypad and press OK.
9. The End Time screen displays. Enter the ending time using Up/Down/Left/Right arrow buttons or 

alphanumeric keypad and press OK.
10. Press the Stop button to return to ready mode.

Subsequent received faxes will be forwarded to the specified server.
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8PC Fax

You can send a fax from your PC without going to the multi-function printer.

The following topics are covered in this chapter:
• Overview on page 92
• Installing PC Fax Software on page 93
• Configure the Fax Port on page 93
• To send a PC Fax on page 93
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Overview

To send a fax from your PC, you need to install the PC-Fax software and customize the software 
settings. 

Installation Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Ensure that the machine is fully functioning in its existing configuration.
• The Fax option must be enabled on the machine. 
• The Software and Documentation CD supplied with your machine must be available. This includes 

the PC-Fax application. 
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Installing PC Fax Software

1. Insert the Software and Documentation CD into your CD drive.
2. Select Open Folder to View Files.
3. Open the Application folder.
4. Open the PCFax folder.
5. Double-click to run the Setup.exe file.
6. The Welcome to the Xerox MFP PC Fax Setup screen appears. Click Install.
7. The Completing the Xerox MFP PC Fax Setup screen appears. Click Finish.

Configure the Fax Port

1. From the Start menu:
• Select Printers and Faxes (Windows XP)
• Select Devices and Printers (Windows 7)

2. Right-click Xerox MFP PC Fax:
• Select Properties (Windows XP) 
• Select Printer Properties (Windows 7)

3. Select the Xerox MFP PC Fax Port and select Configure Port.
4. The Setup Port window opens. In the Select Fax Machine area select the required option to 

connect to your machine:
• Select Local if the machine is connected with a USB cable.
• Select Network if the machine is connected with a network cable.

• If you select Network, enter the IP address of the machine, or select Browse to search 
for the machine on the network.

• When you have connected to the machine, select OK.
5. Click OK to close the Setup Port window.
6. Click Close to close the Printer Properties window.

To send a PC Fax

1. Open the document you want to send.
2. Select Print from the File menu.

The Print window displays.
3. Select the Xerox MFP PC-Fax from your printer list. 
4. Select Properties or Printer Properties. The Xerox MFP PC-Fax Properties screen appears. 
5. Select the required option from the Fax Recipients screen:

• Specify fax options before sending allows you to view the Fax Options screen and configure 
additional fax features, including a cover sheet.

• Automatically send to allows you to add fax recipients and fax your document immediately.
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Specify fax options before sending
a. Select Specify fax options before sending.
b. Select OK. 
c. Select OK. The Fax Options screen appears.
d. In the Phonebook area click Add to add a new fax recipient to your address book or select 

Office Outlook Address Book to add a name from your Office Outlook Address Book.
e. Enter the New Recipient name and Fax Number if required.
f. Click the arrow button to add the name to your Recipients list.
g. You can also click Add in the Recipients area to enter a fax number without saving it to the 

address book.
h. Select the required Fax Quality.
i. Select Use cover page to add a cover page if required.
j. Enter details in the To: and From: fields.
k. Select Advanced to configure the Fax Cover Page Style if required. 
l. Select Notify me on delivery.
m. Click Preview to see an image of your fax document.
n. Click Send to send the fax. 
Your PC begins to send the fax data to the printer which then sends the fax.

Automatically send to
a. Select Automatically send to on the Xerox MFP PC-Fax Properties screen.
b. Enter the required fax number in the Automatically send to box. 
c. Click Add to add an additional fax recipient if required, and click Add Selected. 
d. Click OK.
e. Click OK to send the fax.
Your PC begins to send the fax data to the printer which then sends the fax.
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9USB Port

This chapter explains how to set up the USB Port, which provides for connection to a USB flash drive 
and is used as an input port for printing jobs, storing jobs and performing a software upgrade.

The following topics are covered in this chapter:
• Overview on page 96
• Enable USB Memory Device Port on page 97
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Overview
Overview

USB memory devices are available with a variety of memory capacities to give you more room for 
storing documents, presentations, music and videos, high resolution photographs, or whatever other 
files you want to store or move. You can do the following on your machine using a USB memory device: 
• Scan documents and save them on a USB memory device.
• Print data stored on a USB memory device.
• Manage files stored on a USB memory device (delete and format).
• View available space on a USB memory device.

Your machine supports USB memory devices with FAT16/FAT32 and sector size of 512 bytes. Check 
your USB memory device’s file system from your dealer. You must use only an authorized USB memory 
device with an A plug type connector. 

Use only a USB memory device with metal-shielded connector. 

For further information refer to the WorkCentre 3315DN/3325DN/3325DNI User Guide delivered with 
your machine.

Information Checklist

Before starting please ensure that the following item is available and/or the task has been performed:
• Ensure that the machine is fully functioning in its existing configuration.
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Enable USB Memory Device Port

Note USB Port is enabled on the machine by default.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the System Security link.
6. Select Feature Management.
7. In the Feature Management area, within Physical Ports:

a. Select USB Port to enable the port.
b. Select USB Host to enable the host.

Note If USB Host Port is disabled then your service provider will not be able to upgrade machine 
software.

8. Select Apply to save the changes.
9. Select OK when the acknowledgement message displays.

For further information refer to the WorkCentre 3315DN/3325DN/3325DNI User Guide delivered with 
your machine. 
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10E-mail

This chapter explains how to set up the E-mail feature of the machine.

The following topics are covered in this chapter:
• Overview on page 100
• E-mail Addressing on page 101
• Address Books on page 104
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Overview
Overview

The E-mail feature enables a User to scan paper documents into an electronic format and send those 
documents to one or more e-mail recipients. 

Authentication (Service Access Control) can be enabled on the machine to prevent unauthorized 
access to the network options. If Authentication is enabled a user will be prompted to enter user 
account details, before they can access the E-mail feature. Authentication prevents a user from sending 
an anonymous e-mail from the machine.
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E-mail Addressing

Recipient addresses can be added using any one of the three methods listed below:
• Enter a recipient address manually at the e-mail keyboard screen. i.e. name@company.com.
• Look up a recipient address using LDAP (Lightweight Directory Access Protocol), and/or perform a 

look up using the Local Address book. LDAP provides access to the global, or corporate address 
book. Refer to LDAP Configuration and Address Books on page 105.

• Enter a recipient using the .com key (Smart Key). The Smart Key can be programmed to enter full 
e-mail address i.e. name@company.com, or the Smart Key can be programmed to append a 
domain address, i.e. @company.com. The end user can then enter part of an e-mail address and 
hit the .com key to append the domain address to his entry.

Information Checklist

Before starting, please ensure that the following items are available and/or the tasks have been 
performed:
• Ensure that the machine is fully functioning on the network.
• TCP/IP and HTTP protocols must be enabled on the machine so that the machine web browser 

can be accessed. Ensure that the DNS settings are configured correctly.
• Obtain the address of a functional SMTP (Simple Mail Transfer Protocol) mail server that accepts 

inbound mail traffic.
• Create an e-mail account which the machine will use as the default From address.
• Test the e-mail account by sending an e-mail to the machine’s account. This task should be 

completed at a mail client on your network that supports SMTP and POP3 (Post Office Protocol 3). 

Configure SMTP

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Network Settings link select the Outgoing Mail Server (SMTP) link.
6. In the Simple Mail Transfer Protocol (SMTP) area:

a. Enter the IP or host name of the SMTP Server. 
b. Enter the Port Number. The Port field can have a value from 1 to 65535. The default Port 

Number is 25.
c. Check the SMTP Requires Authentication checkbox if your mail server requires the machine 

to log in.
d. Enter details in the Login ID and Password fields required for the machine to authenticate at 

the mail server.
e. Enter a password in the Confirm Password field.
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f. Select POP3 Authentication to enable this option and enter the required settings.
g. In the Advanced area, select Secure E-mail Connection with SSL/TLS if this option is 

required.
h. Enter a value for server connection timeout in the SMTP Server Connection Timeout field. 

The range is 30 - 120 seconds, and the default is 30 seconds.
i. Enter the required details for the Default From Address.
j. From the Maximum Message Size drop-down menu, select a value between 1MB - 10MB. 

Larger scans will be sent as multiple e-mail messages, divided at page breaks. 
k. Select the SMTP Configuration Test button to test your settings.

7. Select Apply to save the changes.
8. Select OK when the acknowledgement message displays.

Configure the Feature

This feature allows you to configure the default settings for e-mail jobs

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the Scan link.
6. Select Change Default.
7. In the Scan to E-mail area:

a. Select one of the following e-mail types from the Original Type drop-down menu:
• Text
• Text / Photo
• Photo

b. Select one of the following scanning resolutions from the Resolution drop-down menu:
• 100 dpi
• 200 dpi
• 300 dpi

c. Select one of the following scan color types from the Output Color drop-down menu:
• Black and White
• Grayscale
• Color

d. Select one of the following e-mail attachment format types from the File Format drop-down 
menu:
• PDF
• Multi-Page TIFF
• Single Page TIFF
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e. Select the required options for Lighten/Darken and Contrast.
8. Select Scan to E-mail in the left hand menu.

a. Ensure Scan to E-mail is enabled.
b. Enter a valid e-mail address in the Default From: Address field.
c. Enter required information in the Default Subject field.
d. Check the Use default message in scan to email checkbox to change default mail text.
e. In the Default Message field, enter text that you want to appear in the body of e-mails sent 

from the machine.
f. For the Smart Key Address #1 - Smart Key Address #6 fields enter details of default fixed 

details for each numerical key. The default settings for commonly used addresses are already 
configured for .com, .org, .net, .gov and .tv.

g. Select the checkboxes to enable Edit From Address and Replace From Address if required. 
h. Check the Auto Sent To Self checkbox to automatically add the senders From: address to the 

recipient list.
i. Select an option from the Print Confirmation Sheet drop-down menu:

• On Errors Only - This setting will produce a Confirmation Sheet only when error 
information is indicated.

• Always - This setting will produce a Confirmation Sheet that will provide error 
information and indication that the job has reached the recipient(s).

• Never - this setting will not produce a Confirmation Sheet.
9. Select E-mail Text Attachment if this option is required.
10. Select Apply to save the changes.
11. Select OK when the acknowledgement message displays.
Xerox WorkCentre 3315DN/3325DN/3325DNI
System Administrator Guide

103



Address Books
Address Books

Follow the steps in LDAP Configuration and Address Books on page 105.
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11LDAP Configuration and 
Address Books

This chapter explains how to install and setup Address Books.

The following topics are covered in this chapter:
• Overview on page 106
• LDAP Configuration on page 107
• Address Book on page 109
• Import/Export Address Book on page 109
• Create an Individual Address Book Entry on page 110
• Create an E-mail Group Address Book on page 111
• Create a Fax Group Address Book on page 112
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Overview

The machine supports two types of address book:
• Global

A global address book provided by Lightweight Directory Access Protocol (LDAP) services stored on 
a remote server.

• Local
An address book created from a list of addresses saved in a .csv file (Comma Separated by Values) 
format stored locally on the machine.

Both address book types can be configured for use on the machine at the same time.

LDAP is used to access the Corporate Address Book to locate e-mail addresses and other information 
for use with many of the services.

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Ensure your network supports LDAP services.
• Obtain the IP Address or Host Name of your LDAP Server. The machine may also need a login 

name and password if the LDAP server is not configured to allow Anonymous connection.
• Use an LDAP client to validate your settings before inputting them into the Internet Services 

menus. LDAP clients include Microsoft Outlook Express, Microsoft Outlook and Lotus Notes and 
other e-mail clients.

• To use host names, DNS must be configured on the machine.
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LDAP Configuration

General Settings

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Network Security link.
6. Select External Authentication. 
7. Select LDAP Server.
8. In the LDAP Server area enter the IP address or host name and Port Number of the LDAP server.
9. Select the required option for Match Users Login ID to the following LDAP attribute.

10. In the Secure LDAP Connection area, check the Enable checkbox to enable Secure LDAP via SSL.
11. Enter the required information in the LDAP User Search field:

• Search Root Directory - allows you to limit the LDAP search by entering the location on 
the server where the users information is stored.

• Authentication Methods - select either Anonymous or Simple to access the LDAP 
server.

If you selected Simple for Authentication Methods, enter the required Login ID and Password. 
You can check the Enable checkbox for Append Root to Base DN. 
When enabled the bind will append the Root to Append string to the authenticate users login 
ID. This should be enabled whenever the Windows Login attribute is UserPrincipalName. A typical 
Root to Append may look like “@yourcompany.com”.

Note Many Unix/Linux LDAP servers require this attribute to be set and it is used frequently when 
Authentication Methods is set to Simple.

12. Enter the required option for Maximum Number of Search Results. For Maximum Number of 
Search Results, enter amount between 0, 5-300. This is the maximum number of addresses that 
will appear which match the search criteria selected by the user. Set the search results to one less 
than the server will allow. For example, if the LDAP server limit is 75, set the search results to 74 or 
less. A zero value will attempt to return all searches. 

13. For Search Timeout, enter the required setting for the search timeout (0-5-100 seconds).
14. Select LDAP Referral if this option is required.
15. The Search By option offers 4 ways to search the address list depending on the name syntax used 

in your environment. Select one of the following search type:

• Common Name - names are listed by the Common Name LDAP attribute. Common 
Name is the default option.

• Email Address - names are listed by E-mail address.
• Surname/Given Name - names are listed by Surname (Last Name) then Given Name 

(First Name).
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• Custom - Select Custom to enter the required search information in the Custom Search 
box.

The Search Name Order option will help control the returns by allowing the LDAP query to be on 
Common Name or Surname. Lotus Domino will typically require a setting of Surname to allow 
returns of "lastname, firstname".

16. Select the LDAP Configuration Test button to test your LDAP settings.
17. Select Apply to save the changes.
18. Select OK when the acknowledgement message displays.

Verify the LDAP Settings

1. At the machine, press the E-mail button on the control panel. 
2. If Authentication is enabled, enter your Login ID and Password (if required).
3. The Enter From Address screen displays. Enter the sender’s e-mail address and press OK. 
4. If Send to Myself? appears, press the left/right arrows to highlight Yes or No and press OK.
5. The Enter Destination Addresses screen appears. 
6. Enter a few letters of a name in the LDAP Address Book. The machine will return matching names.
7. Press the up/down arrows until the name you want highlights and press OK.
8. If File Format appears, highlight the required file format and press OK.
9. Enter an e-mail subject and press OK.
10. Place a document in the document handler and press the Start button.
11. Verify that the recipient receives the scanned document in their e-mail inbox.
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Address Book

The Internet Services Address Book tab allows you to create individual and group address lists to use 
with the E-mail and Fax features. You can also use the Address Book to create FTP and SMB 
destinations, used with the Scan to Server feature (WorkCentre 3325DN/3325DNI). 

Import/Export Address Book

The Internet Services Address Book page allows you to export and import a list of destinations in a .csv 
(Comma Separated Values) format. The majority of word processing or spreadsheet packages will 
allow you to create, open and edit a .csv file. 

Note You must be logged in to Internet Services as Administrator to Export and Import the 
Address Book.

Procedure

Export the Address Book

The Export Address Book feature allows you to download the current Address Book from the machine, 
even if there are no entries in the Address Book. The Address Book file provides a format which you can 
use to create and Import a new Address Book to the machine. 

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. Select the Address Book icon. The Individual Address Book screen displays.
6. Select the Task drop-down menu and select Export. The 'Do you really want to export address 

book' window appears. Select Yes.
7. Select the Save button.
8. Select a location on your computer to save the AddressBook.csv file.
9. Select the Save button.
10. The AddressBook.csv file will be copied to your computer. 
11. Select Close.

Note It is recommended that you make a copy of the Address.Book.csv file if you want to keep 
any of the current entries in the Address Book.

Edit the Address Book

1. Open an application that supports .csv format, for example Microsoft Excel.
2. Open the AddressBook.csv file that was saved to your computer.
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3. Add your new address destinations to the table following the format in the AddressBook.csv file. 
To create a new Individual address:
a. Enter a Speed Dial number in the Speed No column.
b. Enter the address name in the User Name column.
c. Enter a Fax number if required in the Fax column.
d. Enter an E-mail address if required in the Email column.
e. To create a SMB scan destination, enter the SMB server details as required in the SMB 

columns.
f. To create a FTP scan destination, enter the FTP server details as required in the FTP columns.

4. To create a new Fax Group, enter the details in the Fax Group area.
5. To create a new E-mail Group, enter the details in the Email Group area.
6. Save the file as a *.CSV file.

Note It is recommended that you keep a copy of the new .CSV file once it is created.

Import the Address Book
Note When you import a new Address Book you will overwrite and remove all entries in the 
current Address Book.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. Select the Address Book icon. The Individual Address Book screen displays.
6. Select the Task drop-down menu and select Import. The Task window appears.
7. In the Import File area select Browse to the location of your AddressBook.csv file.
8. Highlight your *.csv file and select Open in the Choose File window. Select the Import button. 
9. The Importing Address Book. Please wait. message appears. When the message disappears, click 

Close.
10. Select the Individual, Fax Groups and E-mail Groups links in the left hand menu to confirm your 

entries appear in the Address Book.

Create an Individual Address Book Entry

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Address Book.
4. Ensure Individual is selected in the left hand menu and select Add.
5. Enter the required information for the Address Book destination:

a. Enter the Name for your individual address
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b. Select a Speed No. if required, to use this address with the Speed Dial feature at the machine.
6. To configure an E-mail destination enter an E-mail Address.
7. To configure a fax address entry, enter Fax Number.
8. To configure a SMB scan destination:

a. Select Add SMB and enter the SMB Server Address, SMB Server Port and login information 
to scan documents to a SMB Server.

b. In the Scan Folder creating policy area select the required options for:
• Create new folder using login name
• Create new folder every (Day, Month, Year)
• Create new folder only if scan output consists of several files
c. Select the required Filing Policy from the drop-down menu.
d. Enter the required File Name.

9. To configure a FTP scan destination:
a. Select Add FTP and enter the FTP Server Address, FTP Server Port, login information and 

path to the FTP folder to scan documents to a FTP Server.
b. In the Scan Folder creating policy area select the required options for:
• Create new folder using login name
• Create new folder every (Day, Month, Year)
• Create new folder only if scan output consists of several files
c. Select the required Filing Policy from the drop-down menu.
d. Enter the required File Name.

10. Select Apply to save your changes. The new entry appears in the Individual Address Book list.

Create an E-mail Group Address Book

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Address Book icon.
4. Select the E-mail Groups link.
5. Select Add Group. 
6. Enter a name in the Group Name field.
7. Select the required Speed Dial number.
8. Select the Add individual(s) after this group is created box to add individuals to the group in the 

next step, or leave it blank to add individuals at a later date.
a. If you select Add individual(s) after this group is created the Add box will appear. 
b. Select the entries in the Individual Address Book list to add to the Group and click the arrow 

button. The individual(s) will appear in the Group list.
9. Click Apply and your group will appear in the E-mail Groups list in the left hand menu.

Note To Add entries to the Group, click the Individual link in the left hand menu and click-drag 
the Individual entry to the required group in the E-mail Groups link in the left hand menu.
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Edit or Delete an Address Book Entry

1. In the Internet Services Address Book page, select the checkbox next to the address you want to 
edit or delete.

2. To edit the address:
a. Click the Edit button.
b. Make the required changes to the address book entry. 
c. Click Apply

3. To delete the address:
a. Select the Delete button.
b. The Do you want to delete selected items? message appears. Select OK.

Create a Fax Group Address Book

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Address Book icon.
4. Select the Fax Groups link.
5. Select Add Group. 
6. Enter a name in the Group Name field.
7. Select the required Speed Dial number.
8. Select the Add individual(s) after this group is created box to add individuals to the group in the 

next step, or leave it blank to add individuals at a later date.
a. If you select Add individual(s) after this group is created the Add box will appear. 
b. Select the entries in the Individual Address Book list to add to the Group and click the arrow 

button. The individual(s) will appear in the Group list.
9. Click Apply and your group will appear in the Fax Groups list in the left hand menu.

Note To Add entries to the Group, click the Individual link in the left hand menu and click-drag 
the Individual entry to the required group in the Fax Groups link in the left hand menu.

Delete a Group

1. In the Fax Groups Address Book area, check the checkbox for the group you want to delete.
2. Select the Delete Group button.
3. Select the OK button for the ‘Do you really want to delete selected items?’ message.

Create Speed Dial Numbers at the Machine

You can set Speed Dial Numbers with the fax numbers you use most frequently. For further 
information refer to the WorkCentre 3315DN/3325DN/3325DNI User Guide delivered with your 
machine.
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This chapter describes how to configure the Security features for the machine.

The following topics are mentioned in this chapter:
• Security Settings on page 114
• Machine Digital Certificate Management on page 116
• SNMP on page 121
• SNMPv3 on page 123
• IP Sec on page 124
• IP Filtering on page 125
• 802.1X Authentication on page 127
• Authentication on page 129
• Display Network Settings on page 135

Security @ Xerox

For the latest information on securely installing, setting up and operating your machine see the Xerox 
Security Information web site located at www.xerox.com/security.
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Security Settings

To prevent unauthorized changes to printer settings, ensure a login ID and password is entered in the 
System Administrator area. 

Administrator Accounts

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the System Security link.
6. Select System Administrator.
7. If required, enter Administrator details for:

• Name
• Phone Number
• Location 
• E-mail Address 

8. The WebUI Access Control checkbox controls access to the Internet Services screen.
9. To change the Administrator Password, select the Change Password box and enter the required 

Login ID and password. The default is admin and 1111 respectively.
10. Select the Advanced button for Advanced Access Control. 
11. Select the required options in the Password Expires in drop down menu.
12. Select Protect Login IPv4 Address if required, and enter the required login IP address that you 

want to protect in the IPv4 Address box.
13. Select the required option for Login Failure Policy. The options are: Off, 3 times and 5 times.
14. Select the required number of minutes from the Auto Logout menu. 
15. Select Security Settings Reset to enable this option if required.
16. Select Save.
17. To control access to the machine control panel, select the Enable box to enable LUI Access 

Control.
18. Select Apply to save the changes.
19. Select OK when the acknowledgement message displays.
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Feature Management

The Feature Management screen allows you to control the Services, Physical Ports, PC Scan Security 
and Network Protocols that are available on the machine.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the System Security link.
6. Select the Feature Management link in the directory tree. 
7. To enable or disable a feature, select the required Enable box or Disable link in the Services, 

Physical Ports, PC Application Security and Network Protocols areas. 
• For the LPR/LPD Protocol, enter the required port number. (The default is 515).
• For Raw TCP/IP Printing Protocol, enter the required port number (The default is 9100).

8. Click Apply to save the changes.

Restart Device

The Restart Device screen allows you to reboot the machine remotely from your desktop.

Note When the machine is restarted, the Network Controller will take some time to restart.
The network connectivity will be unavailable during this time.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the System Security link.
6. Select the Restart Device link in the directory tree. 
7. To reboot the machine select the required Restart Now button
8. The Do you really want to restart the device screen appears. Click Yes. The machine will reboot. 

Internet Services may be unavailable for several minutes while the machine reboots.
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Machine Digital Certificate Management

The following topics are covered in this section:
• Overview on page 116
• Information Checklist on page 116
• Access the Machine Digital Certificate Management Screen on page 116
• Create a Self Signed Certificate on page 117
• Install a CA Signed Device Certificate on page 117
• Enable Secure Connection on page 119

Overview

The machine can be configured for secure access with the SSL (Secure Socket Layer) protocol via 
Digital Certificates. SSL enables secure access to the machine.

To enable SSL on a machine, it needs to have its own digital certificate. When clients make a request to 
the machine, it exports the certificate to provide an encrypted channel.

There are two options available to obtain a server certificate for the machine:
• Have the machine create a Self Signed Certificate
• Create a request to have a Certificate Authority sign a certificate that can be uploaded to the 

machine.

A self-signed certificate means that the machine signs its own certificate as trusted and creates the 
public key for the certificate to be used in SSL encryption.

A certificate from a Certificate Authority or a server functioning as a Certificate Authority (for example 
Windows 2000 running Certificate Services) can be uploaded to the machine. 

Note A separate request is required for each Xerox machine.

Information Checklist

Ensure that the machine is configured with the following items:
• An IP Address or Host Name must be configured on the machine.
• DNS must be enabled and configured on the machine.

Note This is used to set the start time for self signed certificates.

Access the Machine Digital Certificate Management Screen

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
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4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 
Click Properties.

5. In the Security link on the left hand side select the Network Security link.
6. Select the Digital Certificate link. The Certificate Management page displays.
7. Select Add. 

Select one of the following options:
• Install/Create Device Certificate or CSR. The following options are available:

• Create a Self-signed Device Certificate
• Install CA signed Device Certificate
• Create Certificate Signing Request (CSR)

• Install Root Certificate 

Create a Self Signed Certificate

1. In the Install/Create New Certificate area select Create a Self Signed Device Certificate.
2. Select Next.
3. In the Self Signed Certificate area:

a. Enter a friendly name:
b. In the 2 Letter Country Code field enter the Country Code that represents the country in 

which the machine is located. The country code must be entered as a two-character ISO 3166 
country code.

c. If required, enter details in the following fields:
• State/Province Name
• Locality Name
• Organization Name
• Organization Unit

Information entered for these options should describe the machine as per the X500 directory 
scheme but can be any value which is meaningful to the customer to identify the machine.

Note The Common Name is taken from the machine’s IP Address/Host Name and Domain Name. 

d. In the Valid Period box, enter the number of days that the certificate should be valid. Once 
the specified time is reached, the certificate will expire. The start time is based on the current 
machine system time so it is important that the time is set correctly on the machine. 

e. Enter the E-mail Address of the Administrator who is responsible for the secure management 
of the machine.

4. Select the Next button. A message displays to show the success of the certificate creation. 
5. Click the Close button. The certificate displays in the Certificate Management area. 
6. Follow the steps in Enable Secure Connection on page 119.

Install a CA Signed Device Certificate

1. In the Install/Create New Certificate area, select Install CA Signed Device Certificate.
2. Select Next.
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3. In the Certificate Information area:
a. Enter a Friendly Name to identify the certificate
b. Enter the required Private Password and Confirm Password.
c. In the CA Signed Certificate area click Browse to find the certificate file on your computer. 

Select the file and click OK.
d. Click Next.

4. Select the Apply button to accept the changes.
If prompted, enter the Administrator User Name (admin) and Password (1111), and select OK.

5. If successful, the Current Status area will display the message, “A CA Signed Certificate is 
established on this machine.”

6. Follow the steps in Enable Secure Connection on page 119.

Create a Certificate Signing Request

1. In the Install/Create New Certificate area select Create Certificate Signing Request.
2. Select Next.
3. In the Certificate Signing Request (CSR) area:

a. Enter a Friendly Name to identify the request.
b. In the 2 Letter Country Code field enter the Country Code that represents the country in 

which the machine is located. The country code must be entered as a two-character ISO 3166 
country code.

c. If required, enter details in the following fields:
• State/Province Name
• Locality Name
• Organization Name
• Organization Unit

Information entered for these options should describe the machine as per the X500 directory 
scheme but can be any value which is meaningful to the customer to identify the machine.

Note The Common Name is taken from the machine’s IP Address/Host Name and Domain Name. 

d. Enter the E-mail Address of the Administrator who is responsible for the secure management 
of the machine.

4. Click Next.
5. Select the Apply button to accept the changes.

If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.
6. The Certificate Signing Request (CSR) form will appear. In the Certificate Signing Request 

(CSR) area:
a. Select the Save As... button.
b. In the Save As area, select either X.509 or DER.
c. Select Save.

7. Select Save and save the file to your computer. The file is saved as a simple text file, named 
csr.pem (Privacy Enhanced Mail). 

8. Send the file to your Certificate Authority for digital signing.
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9. When you receive the signed certificate back from the Certificate Authority, upload the certificate 
to the machine:
a. Return to the Digital Certificate screen in the Internet Services Network Security menu.
b. Select Upload Signed Certificate.
c. In the Upload Machine Digital Certificate area select Browse.
d. Browse to the signed certificate file on your PC and select the Open button.
e. Select the Upload Certificate button.
f. If successful, the Current Status will display the message “A Signed Certificate is established 

on this machine.”

Note For the upload to be successful, the signed certificate must match the CSR created by the 
machine and must be in a format that the machine supports.

Install Root Certificate

1. In the Install Root Certificate area select Install New Root Certificate.
2. Select Next.
3. In the Self Signed Certificate area:

a. Enter a Friendly Name to identify the certificate.
b. In the Root Certificate area click Browse to find the certificate file on your computer. Select 

the file and click OK.
c. Click Next.

4. Select the Apply button to accept the changes.
If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login.

5. If successful, the Current Status area will display the message, “A Root Certificate is established 
on this machine.”

6. Follow the steps in Enable Secure Connection on page 119.

Enable Secure Connection

Once the machine has a machine Server Certificate, you can enable Secure Connection.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Network Security link.
6. Select the Secure Connection link.
7. Click the Select Certificate button and select the required certificate. Click Select. The certificate 

displays in the Certificate for Secure Connection area.
8. In the Secure HTTP area, select the required option in the HTTPs menu. Select Both HTTP and 

HTTPs to enable Secure IPP or select HTTPs Only.
a. Select Document Folder if required.
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b. Select Import and Export Functions if required.
9. If you selected Both HTTP and HTTPs, select On from the IPPs menu if required.
10. Select Apply to save the changes.
11. Close your web browser and then access the Internet Services screen again. The Security warning 

will display. Self-signed certificates cause browsers to display messages which question the trust 
of the certificate. Select the OK button to continue.

Edit or Delete a Certificate

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Network Security link.
6. Select the Digital Certificate link. The Certificate Management page displays with a list of the 

certificates installed on this machine.
7. Select the box next to the Friendly Name of the certificate that you want to edit or delete. 

• Select the Edit button to edit the certificate. Make the required changes and click Apply.
• Select the Delete button to delete the certificate, and click Yes to confirm.
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SNMP (Simple Network Management Protocol) settings can be configured via Internet Services. 

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Network Settings link select the SNMP link.
6. Select SNMPv1/v2.

a. Select the Enable checkbox to enable SNMPv1/v2 Protocol.
b. Select the required Community Name from the list, or click Add to add a new SNMP 

Community. The Add pop up menu appears.
• Enter the required Name for the SNMP Community.
• Select the required Access Permission.

7. Select Apply to save the changes.
8. Select OK when the acknowledgement message displays.

SNMP Traps

You can specify IPv4 Trap Destination Addresses.

1. From the SNMP page, in the SNMP Traps area select Add.
2. In the Trap Destination Address area, enter details in the IPv4 Address and Port Number fields.
3. In the Traps area, enter the name in the TRAP Community Name field.
4. For Traps to be received check the boxes to select the following Traps:

• Printer Traps.
• Cold Start Generic Traps.
• Warm Start Generic Traps.
• Authentic Failure Traps.

Note When Authentication Failure Traps is enabled, the machine will generate a trap for every 
SNMP request that is received by the machine which contains an invalid community name.

5. Select Apply to save the changes.
6. Select OK when the acknowledgement message displays.

To Edit Community Names or SNMP Traps

1. From the SNMP page, in the Community Names or SNMP Traps area select the name or address 
you want to edit.

2. Select Edit.
3. Change the required options and select Apply to save the changes.
Xerox WorkCentre 3315DN/3325DN/3325DNI
System Administrator Guide

121



SNMP
To Delete Community Names or SNMP Traps

1. From the SNMP page, in the Community Names or SNMP Traps area select the name or address 
you want to delete.

2. Select Delete.
3. Select OK.

Note Changes made to the GET or SET community names for this machine will require 
corresponding GET or SET community name changes for each application which uses the SNMP 
protocol to communicate with this machine (e.g. Xerox CentreWare Web, any third party network 
management applications, etc.).
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SNMPv3

SNMPv3 can be enabled to create an encrypted channel for secure machine management.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Network Settings link select the SNMP link.
6. Select the SNMPv3 link. The SNMPv3 page displays.
7. In the Setup area:

a. Click the Enable box to enable SNMPv3 Protocol.
b. In the Authentication area, enter the required User Name.
c. Enter a password in the Authentication Password field.
d. Enter the password again in the Confirm Password field.
e. For Authentication Algorithm, select either MD5 or SHA. 
f. Enter a password in the Privacy Password field.
g. Enter the password in the Confirm Password field.
h. The Privacy Algorithm displays.

8. Select Apply to save the changes.
9. Select OK when the acknowledgement message displays.
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IP Sec

IP Sec (IP Security) is comprised of the IP Authentication Header and IP Encapsulating Security 
Payload protocols, that secure IP communications at the network layer of the protocol stack, using 
both authentication and data encryption techniques. The ability to send IP Sec encrypted data to the 
printer is provided by the use of a public cryptographic key, following a network negotiating session 
between the initiator (client workstation) and the responder (printer or server). To send encrypted data 
to the printer, the workstation and the printer have to establish a Security Association with each other 
by verifying a matching password (shared secret) to each other. If this authentication is successful, a 
session public key will be used to send IP Sec encrypted data over the TCP/IP network to the printer. 
Providing additional security in the negotiating process, SSL (Secure Sockets Layer protocols) are used 
to assure the identities of the communicating parties with digital signatures (individualized checksums 
verifying data integrity), precluding password guessing by network sniffers.

Enable IP Sec

This procedure requires that you have a Shared Secret available.

IP Sec cannot be enabled until Secure Connection is enabled on the machine. For instructions, refer to 
Enable Secure Connection on page 119.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Network Security link.
6. Select the IP Security link. The IP Security page displays.
7. Click Enable to enable the IP Sec protocol.
8. Enter the Shared Secret and Confirm Shared Secret.
9. Select Apply to save the settings. Select OK when the acknowledgement message displays.
10. The IP Sec Current Status confirms the status of the IP Sec protocol.
11. To change the Shared Secret, click the Change Shared Secret button and enter the new Shared 

Secret information. 
12. Click Apply to save the changes.
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IP Filtering

Overview

The IP Filtering is a security feature that allows you to control access to Internet Services. IP Filtering 
allows you to prevent unauthorized access by TCP/IP (Transmission Control Protocol/Internet Protocol).

The IP Filtering feature provides security to the machine, by allowing you to register the IP addresses 
permitted to communicate with the machine. This feature is used to prevent Raw TCP/IP Printing, 
LPR/LPD, HTTP, Fax to PC, IPP, SNMP and Scan Manager for Network from unauthorized users.

Enable IP Filtering

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Network Security link.

For IPv4 Filtering
6. Select the IPv4 Filtering Enabled checkbox.
7. In the IP Filtering Rules area select the Add button.
8. In the IPv4 Address Range enter the Start IPv4 Address and the End IPv4 Address that you 

want to allow access to the device.
9. Select the options that you want to allow access to in Services to Accept.
10. Select the required Priority.
11. Select Apply to save the changes. 
12. Select OK when the acknowledgement message displays.

For IPv6 Filtering
13. Select the IPv6 Filtering Enable checkbox.
14. In the IP Filtering Rules area select Add. 
15. Enter the IPv6 Address/Prefix that you want to allow access to the device. in the form of the CIDR 

convention. The prefix indicates the number of leftmost bits to be referenced.
16. Select the options that you want to allow access to in Services to Accept.
17. Select the required Priority.
18. Select Apply to save the changes. 
19. Select OK when the acknowledgement message displays.
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Enable MAC Filtering

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Network Security link.
6. Select MAC Filtering in the directory tree. The MAC Filtering page displays.
7. Select the MAC Filtering Enable box.
8. In the MAC Address to Filter Out area select the Add button. 
9. Enter the MAC address that you want to filter out.
10. Select Apply to save the changes. 
11. Select OK when the acknowledgement message displays.
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802.1X Authentication

This is the procedure to follow to install and setup 802.1X Authentication:
• Overview on page 127
• Information Checklist on page 127
• Enable 802.1X at the machine on page 127

Overview

The Xerox machine supports IEEE 802.1X Authentication via Extensible Authentication Protocol (EAP). 
IEEE 802.1X ensures all machines on the network are authenticated and authorized to use the 
network. 802.1X can be enabled for machines connected through wired Ethernet networks.

The Administrator can configure the machine to use one EAP type. EAP types supported on the 
machine are:
• EAP-MD5
• PEAP
• EAP-MSCHAPv2
• TLS

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• 802.1X authentication must be supported on the network where the machine is connected.
• Ensure that your 802.1X Authentication Server and authentication switch are available on the 

network.
• Create a User Name and Password on your Authentication Server which will be used to 

authenticate the machine.

Note Write down the User Name and Password and keep in a safe place. 

Enable 802.1X at the machine

1. Press the Machine Status button on the control panel.
2. Press the Up/Down arrow buttons to highlight Network Settings and press OK.
3. Enter the Administrator Password using the alphanumerical keypad. The default is 1111. Refer to 

Administrator Access on page 19.
4. Press the OK button, the Network Settings menu displays.
5. Press the Up/Down arrow buttons to highlight 802.1x and press OK.
6. Press the Up/Down arrow buttons to highlight On; press OK.
7. Press the Up/Down arrow buttons to highlight one of the following for the Authentication 

Method:
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• TLS
• EAP-MSCHAPv2
• PEAP
• EAP-MD

8. Press OK.
9. Enter the User Name using the alphanumerical keypad and press OK.
10. Enter the password using the alphanumerical keypad and press OK.
11. The screen will display Saved and the machine will reboot.

Enable 802.1X using Internet Services

Authentication via TLS requires a Device Certificate to be configured or uploaded to the machine. For 
instructions refer to Access the Machine Digital Certificate Management Screen on page 116.

Authentication via PEAP and TLS require a Root Certificate to be uploaded to the machine. For 
instructions refer to Install Root Certificate on page 119.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Network Security link.
6. Select 802.1X in the directory tree. The 802.1x Security page displays.

a. For 802.1x Security, check the Enable checkbox to enable.
b. From the Authentication Methods area select one of the following methods:

• EAP-MD5
• EAP-MSCHAPv2
• PEAP
• TLS

7. If you select EAP-MD5, EAP-MSCHAPv2 or PEAP, the Credentials option appears. Enter the 
required details in the Username and Password fields.

8. If you select PEAP or TLS, the Server Validation option appears. Click the Select Certificate 
button and select the required root certificate to provide server validation.

9. If you select TLS, the Device Validation option appears. Click the Select Certificate button and 
select the required certificate to provide device validation.

10. Select the Apply button to accept the changes. 
11. Select OK when the acknowledgement message displays.
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Authentication

Overview

Administrators can configure the machine so that users must be authenticated via the network before 
they can access Scan to E-mail, Scan to FTP and Scan to SMB features. 

The following authentication options can be configured on the machine:

No Authentication 

When No Authentication is enabled users can access features without restriction. No Authentication 
is the default configuration for the machine.

Authentication

Authentication can be configured to verify that a user accessing the machine is a valid user. The user's 
authentication details are verified either remotely by an external network server, or locally by an 
internal database stored in the machine.

The Administrator can select one of these environments to provide authentication:
• Local Authentication
• External Authentication:

• Kerberos (Unix, Linux)
• Kerberos (Windows ADS)
• SMB (Windows NT 4)
• SMB (Windows ADS)
• LDAP

Users are required to enter at least a user name and password to access the machine, based on the 
authentication environment.

Configure Local Authentication

The System Administrator can set up a list of user accounts that are defined locally on the machine. 

Procedure

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
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5. In the Security link on the left hand side select the Authentication link.
6. Select the Authentication link. The Authentication page displays.
7. In the Authentication Method list, select Local Authentication. Ensure User Profile is enabled in 

the Options area.
8. Select Apply to save the changes.
9. Select OK when the acknowledgement message displays.

Create User Accounts

1. Ensure the Authentication menu on the left hand side of the Internet Services screen is selected 
and click the User Profile link in the directory tree. 

2. Select the Add button.
a. Select the required Index number for this user.
a. Enter a name to identify the User in the User Name field.
b. Enter the login name for the User in the Login ID field.
c. Enter the password for the User in the Password field.
d. Re-type the password in the Retype Password field.
e. Enter the user’s Fax Number, if required.
f. Enter the user's e-mail address in the E-mail Address field. Select the Automatically add 

your information to Address Book if you require this feature.
3. Select Apply to add the new User and return to the User Profile page.

To Edit User Information

1. In the User Profile area, select the user and then select the Edit button for the user you want to 
edit. The Edit User page displays.

2. In the Edit User area change the relevant details and select Apply to save the changes and return 
to the User Profile page.

To Remove User

1. In the User Profile area, select the user and then select the Delete button for the user you want to 
remove from the list.

2. Select OK when the message ‘Are you sure you want to remove this user?’ displays.

Verify Authentication is Enabled at the Machine:

1. Press the E-mail button.
2. The Login ID screen appears.
3. Enter a valid user name and press OK.
4. Enter a valid password and press OK. You will have access to the feature.
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Configure External Authentication

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Ensure that the external network server to provide authentication is functional on your network. 

Refer to your manufacturer's documentation for instructions to complete this task.

Configure Kerberos (Unix/Linux)

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Authentication link.
6. Select the Authentication link. The Authentication Method page displays.
7. For Authentication Method select Kerberos (Unix, Linux).
8. Select Apply.
9. In the Network Security link select External Authentication.
10. Select Kerberos Server.
11. Select the Add button. 
12. In the Required Information area:

a. Enter the Realm
b. Enter the Server Address and Port Number 
c. Select Make To Default Server if required.

13. In the Additional Information area enter details in the Backup Server field. Enter the server 
name and port number.

14. Select Apply to save the changes.
15. Select OK when the acknowledgement message displays.
16. Follow the steps in Verify Authentication is Enabled at the Machine: on page 130 to check that 

you have setup authentication correctly.

Configure Kerberos (Windows ADS)

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
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5. In the Security link on the left hand side select the Authentication link.
6. Select the Authentication link. The Authentication Method page displays.
7. For Authentication Method select Kerberos (Windows ADS).
8. Select Apply to accept the changes.
9. In the Network Security link select External Authentication.
10. Select Kerberos Server.
11. Select the Add button. 
12. In the Required Information area:

a. Enter the Realm.
b. Enter the Server Address and Port Number. 
c. Select Make To Default Server if required.

13. In the Additional Information area enter details in the Backup Server field. Enter the server 
name and port number.

14. Select Apply to save the changes.
15. Select OK when the acknowledgement message displays.
16. Follow the steps in Verify Authentication is Enabled at the Machine: on page 130 to check that 

you have setup authentication correctly.

Configure SMB (Windows NT 4)

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Authentication link.
6. Select the Authentication link. The Authentication page displays.
7. Select SMB (Windows NT 4).
8. Select Apply to accept the changes.
9. In the Network Security link select External Authentication.
10. Select SMB Server.
11. Select the Add button. 
12. In the Required Information area:

a. Enter the Domain.
b. Enter the Server Address and Port Number. 
c. Select Make To Default Server if required.

13. In the Additional Information area enter the Backup Server and Port Number.
14. Select Apply to save the changes.
15. Select OK when the acknowledgement message displays.
16. Follow the steps in Verify Authentication is Enabled at the Machine: on page 130 to check that 

you have setup authentication correctly.
Xerox WorkCentre 3315DN/3325DN/3325DNI
System Administrator Guide

132



Authentication
Configure SMB (Windows ADS)

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Authentication link.
6. Select the Authentication link. The Authentication page displays.
7. Select SMB (Windows ADS).

8. Select Apply to accept the changes.
9. In the Network Security link select External Authentication.
10. Select SMB Server.
11. Select the Add button. 
12. In the Required Information area:

a. Enter the Domain.
b. Enter the Server Address and Port Number. 
c. Select Make To Default Server if required.

13. In the Additional Information area enter the Backup Server and Port Number.
14. Select Apply to save the changes.
15. Select OK when the acknowledgement message displays.
16. Follow the steps in Verify Authentication is Enabled at the Machine: on page 130 to check that 

you have setup authentication correctly.

Configure LDAP

Enable LDAP Authentication

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select Properties.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Authentication link. 
6. Select the Authentication link. The Authentication Method screen displays.
7. Select LDAP.
8. Select Apply to accept the changes.
9. Select OK when the acknowledgement message displays.
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Configure LDAP Settings

Configure LDAP server information on the machine. For instructions, see LDAP Configuration on 
page 107.

When you have configured LDAP settings, follow the steps in Verify Authentication is Enabled at the 
Machine: on page 130 to check that you have setup authentication correctly.
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Display Network Settings

The Display Network Settings feature allows you to control the network information that displays on 
the machine control panel. 

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side select the Network Security link.
6. Select Display Network Settings in the directory tree. The Display Network Settings page 

displays.
7. In the Options area, select one of the following options:

• Hide Network Information
• Show IPV4 Address
• Show HostName

8. Select Apply to save the changes.
9. Select OK when the acknowledgement message displays.
Xerox WorkCentre 3315DN/3325DN/3325DNI
System Administrator Guide

135



Display Network Settings
Xerox WorkCentre 3315DN/3325DN/3325DNI
System Administrator Guide

136



13CentreWare Internet 
Services

This chapter explains how to enable and use the CentreWare Internet Services (Internet Services) 
feature of the machine. 

The following topics are covered in this chapter:
• Overview on page 138
• Status on page 139
• Jobs on page 140
• Print on page 142
• Address Book on page 143
• Properties on page 144
• Support on page 158
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Overview

Internet Services uses the embedded HTTP Server on the machine. This allows you to connect to the 
machine through a web browser, to configure or change machine settings. 

Enter the IP Address of the machine in the URL (Universal Resource Locator) field of a browser to 
access the Internet Services home page.

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• The machine should be connected to the network with TCP/IP enabled and configured.
• An existing operational workstation with TCP/IP Internet or Intranet accessibility is required.
• HTTP (Hyper Text Transfer Protocol) should be enabled on the machine. HTTP is enabled by 

default. If you need to enable HTTP, see Enable HTTP Using the LUI on page 138.

Enable HTTP Using the LUI

Hyper Text Transfer Protocol (HTTP) must be enabled on the machine in order to access the embedded 
web pages. 

Note HTTP is enabled by default on the machine. 

1. Press the Machine Status button on the control panel.
2. Press the Up/Down arrow buttons to highlight Network Settings; press OK. 
3. If required, enter the Administrator Password using the alphanumerical keypad. The default is 

1111. Refer to Administrator Access on page 19.
4. Press the OK button, the Network Settings menu displays.
5. Press the Up/Down arrow buttons to highlight HTTP Activate. Press OK.
6. Press the Up/Down arrow buttons to highlight On; press OK.

The Save screen will display and return to the Network Settings menu.

Access Internet Services

1. Open a web browser from your workstation.
2. In the URL field, enter http:// followed by the IP Address of the machine. For example: If the IP 

Address is 192.168.100.100, enter the following into the URL field: http://192.168.100.100.
3. Press Enter to view the Home page.
4. Select an icon to access the desired page, or select the Index icon at the top of the machine web 

page to access the index list.
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The Status page allows you to view any Active Alerts displayed by the machine, and see the status of 
the print cartridge. The Usage Counters page allows you to view the number of impressions, faxes and 
scans sent by the machine. Information about the machine setup and network information can also be 
viewed. The Print Information page allows you to print the Configuration Report, Address Book, 
Completed Jobs list and other documents about the machine usage. 

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Status icon. 
4. Select the option in the menu on the left side of the page to view the required information:

• Active Alerts: shows current issues reported by the machine and the skill level required to 
fix them.

• Supplies: shows the status of the Xerox Black Print Cartridge.
• Usage Counters: shows the Machine Serial Number and the number of impressions 

completed by the machine.
• Current Settings: which contains Machine Information and Network Information. 

Machine Information displays information about the System, Printer, Copy, Fax and 
Scan features. Network Information displays information about the Protocols 
configured on the machine.

• Print Information: allows you to print System, Scan, Authentication, Fonts and Address 
Book information configured on the machine.

Print Information

1. In the Status page, select Print Information.
2. Select the required report in the Print Information screen by selecting the checkbox next to the 

report that you want to print.
3. Select the Print button. 
4. Select OK when the acknowledgement message displays.
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Jobs

The Jobs tab enables you to setup and manage Local Drive Folders and provides access to the Job 
Management folders.

The Jobs tab is not present on the WorkCentre 3315DN unless the optional memory is installed and 
the RAM Disk enabled. When the Jobs tab is enabled the only options available are Active Jobs, Stored 
Print and Secure Print.

Folders

The Local Drive feature (WorkCentre 3325DN/3325DNI), allows you to scan documents to the device 
hard drive and store them in folders. Folders are created and managed using Internet Services. Once a 
folder has been created, it is available for storing documents when the Local Drive option is selected at 
the device.

Create a Folder

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Click Login to login as the administrator. Enter the Administrator User Name (admin) and 

Password (1111), and select Login. 
4. Select the Jobs icon. The Folders page displays. By default, the Default Public folder is available 

to store scanned images. 
5. To create a new folder, ensure the Folders option is selected in the left hand menu and select the 

Add Folder button. 
6. Enter the name of your folder in the Folder Name area
7. Enter the owner of your folder in the Owner area.
8. To create a private folder, select the Private Folder checkbox. A private folder requires you to enter 

a password to access the folder. Enter a password for your private folder in the Password and 
Confirm Password areas.

9. Select Apply. The new folder will appear in the Folders list.
10. Your new folder will be available to select in the Local Drive feature at the machine. 

Scan a document to the Local Drive

1. At the machine, press the Machine Status button.
2. Select the up/down arrows to highlight the Local Drive option and press OK.
3. Select the up/down arrows to highlight Local Drive Feature and press OK.
4. Select the up/down arrows to highlight the Scan to Local Drive option and press OK.
5. The Default Public folder appears and any other folders that you created within the Internet 

Services Jobs tab. Select the required folder.
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6. Select the required options for Original Size, Resolution, Output Color, 2-Sided, Lighten/Darken 
and Contrast.

7. Place your originals on the device document glass or in the automatic document feeder.
8. Press the green Start button to store your document on the local drive.

Print a document from the Local Drive using Internet Services

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Click Login to login as the administrator. Enter the Administrator User Name (admin) and 

Password (1111), and select Login. 
4. Select the Jobs icon. The Folders page displays. 
5. Double-click the folder which contains the document you want to print.
6. Enter the folder password if the Private Folder Authentication screen appears, and click Apply.
7. Select the document you want to print.
8. In the Task menu, select Print.
9. Enter the required Print Options for No. of Copies, Auto Fit and 2-Sided.
10. Click Print.
11. Retrieve your printed document from the machine.

For further information refer to the WorkCentre 3315DN/3325DN/3325DNI User Guide delivered with 
your machine.

Job Management

The Job Management page allows you to view Active Jobs, Completed Jobs, Stored Print, Secure 
Print and Secure Fax Received Jobs, where these options are available on the machine.

To view the Job Management page

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Job Management link.
4. To view the status of current jobs at the machine select the Active Jobs link. To delete an active 

job, select the required job and press the Delete button.
5. To view the details of finished jobs at the machine, select the Completed Jobs link. 
6. To view the status of stored print jobs select the Stored Print link.
7. To view the status of secure print jobs select the Secure Print link.
8. To view the status of secure received faxes select the Secure Received Fax link. 

For further information refer to the WorkCentre 3315DN/3325DN/3325DNI User Guide delivered with 
your machine.
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File Download

Print-ready documents can be quickly and easily submitted for printing using the File Download page. 

A print-ready document is a file that has been formatted and saved for printing from the application 
that created it, or the Print to File check box was checked in the printer driver screen.

The following file formats can be printed from the Job Submission page:
• PDF
• PCL
• PostScript® 
• Plain Text
• PRN files

Large print jobs need adequate space on your hard drive when printing through Internet Services.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Print icon. The Print Options page displays.
4. Select the number of copies required in the Quantity menu.
5. Select the required orientation of your print from the Orientation menu.
6. Select the required option for 2-Sided printing.
7. In the Print-Ready File area, select the Browse button. The File Download page displays.
8. Select the print-ready document and select OK.
9. Select Apply to print the document.
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Address Book

The Address Book page allows you to create individual and group address lists to use with the Fax and 
E-mail features. For instructions on how to create address book entries, refer to Address Book on 
page 109.
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The Properties tab allows you to configure Machine Settings, Network Settings and Security 
information. You must be logged in as the Administrator to view the Properties pages.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.

Machine Settings

The Machine Settings menu contains the following features:
• Firmware Version 
• System
• Printer
• Copy
• Fax
• Scan
• E-mail Notification

Firmware Version

1. Access the Properties tab.
2. In the Machine Settings link select the Firmware link. The Version Information area displays the 

following information:
• System version
• Main Controller
• Network
• IP Core software version
• Image Output Terminal
• PCL5X
• PCLXL
• PS
• PDF
• TIFF
• IBM/EPSON
• Tray 2 Firmware Version
• XPS (WorkCentre 3325DN/3325DNI)
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System

The System page allows the user to change the following preferences:
• Setup - includes General machine information such as date and time and clock mode.
• Earth Smart - allows you to set features to save energy and paper on the machine, and view a 

report.
• Input Tray - allows you to set the input tray information.
• Sound/Volume - allows you to set options for the Key Sound, Alarm Sound, Speaker and Ringer.

Setup

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon. 
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the System link.
6. Select Setup. The General page displays.
7. In the Host Name, Location, Contact, Xerox Asset Tag Number and Customer Asset Tag 

Number areas enter the required information for the device.
8. From the Clock Mode drop-down menu select either 12 hour(s) or 24 hour(s).
9. Enter the date and time in the Date & Time fields.
10. Select the required language from the Language drop-down menu.
11. Select the required emulation from the Emulation drop-down menu.
12. From the Power Save drop-down menu select the required time for the machine to enter power 

save mode.
13. Select the required options for the Power Save Wakeup Event.
14. From the System Timeout drop-down menu select the required timeout.
15. Select the required options for:

• Auto Continue
• Altitude Adjustment
• Toner Low Alert
• Toner Save
• Line Termination
• Job Timeout

16. Select Apply to save the changes.
17. Select OK when the acknowledgement message displays.

Earth Smart

The Earth Smart feature allows you to configure options to decrease the amount of energy and paper 
used in the printing process and displays a visual representation of savings made. 
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Configure Earth Smart Settings

1. In the Machine Settings link select the System link.
2. Select Earth Smart. 
3. Select Settings. The Default Mode page displays.
4. Select the required option:

• Select On to enable Earth Smart,
• Select On-forced to enter a 4 - 8 digit password. 

5. In the Features Configuration area:
a. Select Factory Default if you want to retain the default Earth Smart settings.
b. To change the Earth Smart settings, select Custom Settings.

• Select Edit and Preview Simulator. 
• Select the required Copy Settings for 2-Sided, N-Up and Toner Save. The simulator 

shows estimates for the CO2, Energy and Paper savings.
• Select the required Folder Print Settings for 2-Sided and Toner Save.
• Select the required PC Driver Print Settings for 2-Sided, N-Up, Skip the Blank Pages, 

and Toner Save.
c. Click OK to save your changes.

View the Earth Smart Report

The Earth Smart Report shows you the Total CO2 Emission, Total Saved Energy and Total Saved Paper 
of an Earth Smart job in a specific period, compared with a normal job.

1. In the Earth Smart menu select Report.
2. Select the time frame for your report from the Period menu. The information will display in the 

Earth Smart Information Report area.

Input Tray

To access the Input Tray settings

1. In the Machine Settings link select the System link. 
2. Select the Input Tray link. The Input Tray page displays.
3. In the Paper Size area, from the following drop-down menus select the required paper size 

settings:
• Tray 1
• Tray 2

Note Tray 2 is only available with the Optional Tray installed.

• Bypass Tray
4. In the Paper Type area, from the following drop-down menus select the required paper type 

settings:
• Tray 1
• Tray 2
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• Bypass Tray
5. To enable Bypass Mode, select the Enable checkbox in the Tray Mode area if required.
6. Select Apply to save the changes.

Sound / Volume

To access the Sound/Volume settings:

1. In the Machine Settings link select the System link. 
2. Select Sound/Volume. 
3. In the Sound area:

a. Check the Key Sound checkbox to enable sound when pressing a key on the control panel.
b. Check the Alarm Sound checkbox to enable the alarm sound. 
c. From the Speaker drop-down menu select either On, Off or Comm.
d. From the Ringer drop-down menu select the required level of the ring.

Printer

The Printer screens allow you to set the options for:
• Graphic
• Layout
• PCL
• PostScript
• PDF
• XPS (WorkCentre 3325DN/3325DNI)
• EPSON/IBM
• Form Overlay (WorkCentre 3325DN/3325DNI)
• Font and Macro Download (WorkCentre 3315DN)

Graphic

To access the Graphic settings:

1. In the Machine Settings link select the Printer link. 
2. Select Graphic. 
3. In the Graphic area, from the following drop-down menus select the required settings:

• Resolution
• Darken Text

4. Select Apply to save the settings.
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Layout

To access the Layout settings:

1. In the Machine Settings link select the Printer link. 
2. Select Layout. 
3. In the Layout area, from the following drop-down menus select the required options:

• Layout
• Common Margin
• Advanced Margin - select the Setting buttons to change the options for Tray 1, Tray 2, 

Bypass Tray and Emulation Margin.
4. Select Apply to save the settings.

PCL

To access the PCL settings:

1. In the Machine Settings link select the Printer link. 
2. Select PCL. 
3. In the PCL area, from the following drop-down menus select the required options for the PCL font:

• Typeface
• Symbol Set
• Lines
• Pitch
• Courier

4. Select Apply to save the settings.

PostScript

To access the PostScript settings:

1. In the Machine Settings link select the Printer link. 
2. Select PostScript. 
3. In the PostScript area, select Enable to select Print PostScript Error.
4. Select Apply to save the settings.

PDF

To access the PDF settings:

1. In the Machine Settings link select the Printer link. 
2. Select PDF. 
3. In the PDF area, select the required settings:

• Print PDF Error
• Transparency
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• Auto Fit
4. Select Apply to save the settings.

XPS (WorkCentre 3325DN/3325DNI)

To access the XPS settings:

1. In the Machine Settings link select the Printer link. 
2. Select XPS. 
3. In the XPS area, select Enable to select Print XPS Error.
4. Select Apply to save the settings.

EPSON/IBM

To access the EPSON/IBM settings:

1. In the Machine Settings link select the Printer link. 
2. Select EPSON/IBM. 
3. In the EPSON/IBM area, select the required settings:

• Font
• Auto Wrap
• Character Set
• Character Table
• LPI
• Pitch

4. Select Apply to save the settings.

Form Overlay (WorkCentre 3325DN/3325DNI)

To access the Form Overlay settings:

1. In the Machine Settings link select the Printer link. 
2. Select Form Overlay. 

Note You must add at least one form overlay to change the Form Overlay Mode from Off.

3. In the Form Overlay area select the Add button to add a form overlay.
4. Select the Browse button to select the required file.
5. Enter a description in the Description box.
6. Select the Apply button.
7. In the General area, select the required option for the Form Overlay from the Mode menu.

Font and Macro Download (WorkCentre 3315DN)

The Font and Macro Download page allows you to add the following to the machine:
• PCL Font
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• PCL Macro
• PS Font

Note Ensure the required font or macro file is available on your computer.

1. In the Machine Settings link select the Printer link. 
2. Select Font and Macro Download.
3. Select the PCL Font, PCL Macro or PS Font tabs as required.
4. Select Add. 
5. In the File area:

a. Select the Browse button.
b. Select the required font or macro file on your computer.
c. Select Open.

6. If you selected PCL Font or PCL Macro, enter the required ID.
7. Select the Apply button.
8. Select the Print List button to view the font or macro list.

Copy

The Copy page allows you to set default copying settings.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the Copy link. 
6. In the General area, ensure the Enable checkbox is selected to enable the Copy feature.
7. In the Change Default area:

a. From the Reduce/Enlarge drop-down menu select the required size.
If you select Variable enter custom details in the Custom Reduce/Enlarge field. 

b. From the Lighten/Darken drop-down menu, select the required darkness option.
c. From the Contrast drop-down menu, select the required contrast.
d. From the Original Type drop-down menu, select one of the following:

• Text
• Text/Photo
• Photo

8. Select Apply to save the changes.
9. Select OK when the acknowledgement message displays.
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Fax

The Fax page allows you to set default fax settings and fax forward setting. For instructions to set 
default fax settings, refer to Fax Defaults using Internet Services on page 81. For instructions to set fax 
forward settings, refer to Fax Forward on page 85.

Scan

The Scan page allows you to set default scan settings and configure the Scan to E-mail, Scan to Server 
(WorkCentre 3325/3325DNI) and Scan Security settings. 

For instructions to set default scan settings, refer to Scan to Server (WorkCentre 3325DN/3325DNI) on 
page 65 and Scan to Network/Local PC on page 75. 

For instructions to configure Scan Security, refer to Configure Scan Security on page 72.

For instructions to configure Scan to E-mail refer to E-mail on page 99. 

E-mail Notification

The E-mail Notification page allows you to set up e-mail alerts to notify users or operators of 
problems as they occur on the machine. 

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Machine Settings link select the E-mail Notification link. 
6. Select the Enable checkbox to enable E-mail Notification.
7. To create a new e-mail notification, in the Recipients & Conditions area, select Add. The Add 

screen appears.
8. Enter the name of your recipient in the Name box.
9. Enter the E-mail address(es) for the people that you want to be notified of the machine problems. 

Multiple e-mail addresses can be entered; the e-mail addresses must be separated by semi-colons.
10. In the Notification area, click the box next to Notification to be notified of all events, or select the 

specific events that you want to be notified of: 
• Consumable Shortage Warning
• System Errors
• Device Status
• Firmware Upgrade Notification
• Warn me when Admin Password is expired
• Warn me when Admin Password has been changed
• Security Settings Reset
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11. Some notifications require additional settings: 
a. If you select Consumable Shortage Warning, select Setting... and enter the required setting 

for the Toner Level. Select Apply.
b. If you select Device Status, select Setting... and enter the required information for 

Notification Schedule and Reports to be attached in E-mail. Select Apply.
12. Select Apply to save the changes.

Network Settings

The Network Settings screens allow you to set the properties for the following options:
• General, which includes Ethernet Speed
• TCP/IPv4
• TCP/IPv6
• Raw TCP/IP, LPR, IPP
• Telnet
• WSD
• SLP
• UPnP
• mDNS
• CIFS
• SNMP
• Outgoing Mail Server (SMTP)
• Wireless
• Restore Default

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Network Settings link select the General link.

General

The General page allows you to set the Ethernet Speed and view the device MAC address. For 
instructions on how to set the Ethernet Speed, refer to Setting the Ethernet Speed Using Internet 
Services on page 26.
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TCP/IP

The TCP/IPv4 and TCP/IPv6 pages allow you to configure the TCP/IP settings on the device. For 
instructions refer to Network Installation on page 27.

Raw TCP/IP, LPR, IPP

The Raw TCP/IP, LPR IPP page allows you to configure the Raw TCP/IP (Port 9100), LPR (Line Printer 
Remote) and IPP (Internet Printing Protocol) settings on the device. For instructions, refer to Windows 
Printing on page 53.

Telnet

The Telnet page allows you to configure Telnet settings on the device.

1. In the Network Settings link select the Telnet link. 
2. Select Enable to enable the Telnet Protocol.
3. Enter the required information to configure the following settings:

• Port Number
• Login ID
• Password

4. Select Apply to save the settings. 

WSD

The WSD page allows you to enable the WSD protocol on the device.

1. In the Network Settings link select the WSD link. 
2. Select Enable to enable the WSD Protocol.
3. Select Apply to save the settings. 

SLP

The SLP page allows you to configure the SLP protocol (Service Location Protocol) on the device.

1. In the Network Settings link select the SLP link. 
2. Select Enable to enable the SLP Protocol.
3. Enter the required information to configure the following settings:

• Scope 1, 2 and 3
• Message Type
• Multicast Radius
• Registration Lifetime

4. Select Apply to save the settings. 
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UPnP

The UPnP page allows you to configure the SSDP protocol (Simple Service Discovery Protocol) on the 
device.

1. In the Network Settings link select the UPnP link. 
2. Select Enable to enable the SSDP Protocol.
3. Enter the required information for SSDP TTL.
4. Select Apply to save the settings.

mDNS

The mDNS page allows you to enable the MDNS protocol (Multicast DNS) on the device. This protocol 
is used in Bonjour (formerly Rendezvous) from Apple.

1. In the Network Settings link select the mDNS link. 
2. Select Enable to enable the mDNS Protocol.
3. Select Apply to save the settings. 

CIFS

The CIFS page allows you to configure the CIFS Shared Folder settings on the device. 

1. In the Network Settings link select the CIFS link. 
2. Select Enable to enable the CIFS Server.
3. Enter the required information to configure the following settings:

• Max Connection
• Anonymous
• Login ID
• Password

4. Select Apply to save the settings. 

SNMP

The SNMP page allows you to configure the SNMP (Simple Network Management Protocol) v1, v2 and 
v3 settings on the device. For instructions, refer to SNMP on page 121.

Outgoing Mail Server (SMTP)

The Outgoing Mail Server (SMTP) page allows you to configure the SMTP (Simple Mail Transfer 
Protocol) settings on the device. For instructions, refer to Configure SMTP on page 101.
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Wireless (WorkCentre 3325DNI)

The Wireless page allows you to view the wireless connection status and configure the wireless settings 
on the device. For instructions refer to Configure Wireless Connectivity Using Internet Services 
(WorkCentre 3325DNI) on page 24.

Restore Default

The Restore Default page allows you to clear the machine’s network settings. 

1. In the Network Settings link select the Restore Default link.
2. Select the Clear button.
3. The Do you really want to restore network settings message appears. Click Yes.
4. Reboot the machine for changes to take effect.

Security

The Security screens allow you to view and set the properties for the following options:
• Security Summary
• System Security
• Network Security
• Authentication

Security Summary

The Security Summary page allows you to view the settings for: 
• System Security
• Network Security
• Authentication

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Properties icon.
4. If prompted, enter the Administrator User Name (admin) and Password (1111), and select Login. 

Click Properties.
5. In the Security link on the left hand side, select the Security Summary link. 

The System Security screen displays information about Access Control, Advanced Access 
Control and Mass Storage Device Security.

6. In the Security Summary page, select the Network Security tab. The Network Security tab 
displays the settings configured on the device for:

• Secure Connection (HTTPs)
• Simple Network Management Protocol v3
• IP Security
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• IP and MAC Address Filter
• 802.1x Security

7. In the Security Sumary page, select the Authentication tab. Information about the 
Authentication Method and User Profile displays.

System Security

The System Security pages allow you to configure security settings on the device for:
• System Administrator
• Feature Management
• Restart Device

System Administrator

The System Administrator page allows you to change the administrator password and control access 
to Internet Services (the Web UI) and the device control panel (the LUI or Local User Interface). For 
instructions, refer to Administrator Accounts on page 114.

Feature Management

The Feature Management page allows you to control access to the machine services, physical ports 
and network protocols used on the device. For instructions, refer to Feature Management on page 115.

Restart Device

The Restart Device screen allows you to reboot the machine remotely from your desktop. For 
instructions, refer to Restart Device on page 115.

Network Security

The Network Security pages allow you to configure security settings on the device for:
• Digital Certificate
• Secure Connection
• SNMPv3
• IP Security
• IPv4 Filtering
• IPv6 Filtering
• MAC Filtering
• 802.1x
• External Authentication Server
• Display Network Settings
Xerox WorkCentre 3315DN/3325DN/3325DNI
System Administrator Guide

156



Properties
For instructions on how to configure the Network Security settings, refer to Security Settings on 
page 114.

External Authentication

The External Authentication screen allows you to configure the server information used to validate 
machine users and is used with the Authentication feature. For information on how to configure 
Authentication, refer to Authentication on page 129.

Display Network Settings

The Display Network Settings screen allows you to control the network information that displays on 
the machine control panel. For further information, refer to Display Network Settings on page 135.

Authentication

The Authentication pages allow you to enable the Authentication Method to validate machine users, 
and configure the User Profile information. For information on how to configure Authentication, refer 
to Authentication on page 129.
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Support

The Support tab provides details of the machine Version Information and allows you to perform a 
Firmware Upgrade. You can also configure Contact Information for the System Administrator and 
Xerox support information. The Support tab provides Support Links to pages on www.xerox.com that 
provide helpful information, for example drivers and documentation.

Note You must be logged in as the Administrator to perform a Firmware Upgrade.

Version Information

The Version Information area displays the machine’s firmware versions.

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Support icon. The Version Information page displays. 

Firmware Upgrade

For information on how to upgrade the machine firmware, refer to Upgrade using Internet Services on 
page 163.

To Edit Contact Information Details

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Support icon. The Support page displays. 
4. In the Contact Information: System Administrator area, select the links to enter or edit details in 

the following fields:
• Name
• Phone Number
• Location
• E-mail Address

5. In the Xerox Support area, enter information for the following fields:
• Customer Support Phone Number
• Services Phone Number
• Supply Phone Number

6. Select Apply to save the changes.
7. Select OK when the acknowledgement message displays.
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Support Links

To view Support Links or to register your device on www.xerox.com:

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Support icon. 
4. Select Support Links within the Support tab. 
5. Select the required link to access information.
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14Software Upgrade

This chapter explains how to upgrade the machine software when requested by a Xerox Customer 
Support Centre Representative and includes the following topics.
• Overview on page 162
• Upgrade using Internet Services on page 163
• Upgrade using a USB flash drive on page 165
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Overview

The Software Upgrade feature allows the customer to upgrade the machine software as requested by 
a Xerox Customer Support Centre Representative, without needing a Customer Service Representative 
to be present.

IMPORTANT: Any jobs in the queue must be allowed to complete or be deleted before initiating a 
software upgrade.

When should I upgrade the software?

Xerox is continually seeking to improve its products and a software revision may become available to 
improve the functionality of the machine. Your Customer Support Centre Representative will instruct 
you to upgrade your machine when it is necessary.

How do I upgrade the software?

There are two methods for upgrading the software on the machine:
• Upgrade over a network connection using CentreWare Internet Services (via a print submission). 

Refer to Upgrade using Internet Services on page 163.
• Upgrade directly at the machine with a USB flash drive connected to the USB port on the front of 

the machine. Refer to Upgrade using a USB flash drive on page 165.
Xerox WorkCentre 3315DN/3325DN/3325DNI
System Administrator Guide

162



Upgrade using Internet Services
Upgrade using Internet Services

Note Any jobs in the queue must be allowed to complete or be deleted before initiating a 
software upgrade. This procedure will prevent further jobs from being received until the upgrade 
has completed. All configured network settings and installed options will be retained by the 
machine after the Software Upgrade process. 

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Obtain the new software upgrade file for your machine from the www.xerox.com web site or from 

your Xerox Customer Support Representative. The upgrade file will have an extension of .hd. 
Download the upgrade file to a local or network drive. You will be able to delete the file after the 
upgrade procedure.
It is important to obtain the correct upgrade file for your particular model of machine. 
For instructions to determine which model of machine you have, refer to Properties on page 144.

• TCP/IP and HTTP protocols must be enabled on the machine so that the machine web browser 
can be accessed.

Procedure

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Login link at the top of the screen. Enter the Administrator User Name (admin) and 

Password (1111), and select Login. 
4. Select Properties.
5. In the Security link on the left hand side select the System Security link.
6. Select the Feature Management link in the directory tree. 
7. Select the Firmware Upgrade Enable box. 
8. Click Apply to save the changes.
9. Select the Support tab.
10. In the Firmware Upgrade link select the Upgrade Wizard button. 
11. The Firmware Upgrade Wizard screen appears. In the Firmware File area:

a. Select Browse.
b. Locate and select the software upgrade .hd file obtained earlier.
c. Select Open.

12. Select Apply to send the file to the machine.
13. The file will be sent to the printer and will disable the printing functionality. The web browser will 

become inactive and you will not be able to access the machine via this method until the upgrade 
has completed and the machine has rebooted. The upgrade should take no longer than 30 
minutes.
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14. Once the machine has completed the upgrade it will reboot automatically. The configuration 
report will print (if enabled). Check the configuration report to verify that the software level has 
changed.
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Upgrade using a USB flash drive

This section provides instructions to upgrade machine software via a Software Upgrade file stored on a 
USB flash drive.

Note The print queue will be used for this procedure, so further jobs will not be printed until the 
upgrade has finished.

All configured network settings and installed options will be retained by the machine after the 
Software Upgrade process.

Information Checklist

Before starting please ensure that the following items are available and/or the tasks have been 
performed:
• Obtain the Software Upgrade file from www.xerox.com or your Customer Service Representative. 

The file will have an .hd extension.
IMPORTANT: It is important to obtain the correct upgrade file for your particular model of 
machine. Xerox recommends that the file is stored in a subdirectory on the USB flash drive so that 
it is easier to locate from the machine’s User Interface.

• If you are performing the upgrade on a networked (connected printer) machine, ensure that the 
machine is online before continuing.

Procedure

1. At your workstation, open the web browser and enter the IP Address of the machine in the 
Address Bar.

2. Press Enter.
3. Select the Login link at the top of the screen. Enter the Administrator User Name (admin) and 

Password (1111), and select Login. 
4. Select Properties.
5. In the Security link on the left hand side select the System Security link.
6. Select the Feature Management link in the directory tree. 
7. Select the Firmware Upgrade Enable box. 
8. Click Apply to save the changes.
9. At your printer, insert a USB memory device into the USB port at the front of your machine. The 

USB Menu displays automatically on the control panel.
10. Select Print from USB and press OK. Your machine automatically detects the device and reads 

data stored on it.
11. Press the Up/Down arrow buttons until the Upgrade .hd file you want is highlighted and press OK.

If you see + in the front of a folder name, there are one or more files or folders in the selected 
folder. If you selected a folder, press the Up/Down arrow buttons until the file you want is 
highlighted and press OK. 

12. Press the green Start button to send the file to the machine and start the upgrade process.
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13. The control panel will indicate the status of the upgrade and the machine will reboot once it is 
complete.
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15Troubleshooting

This chapter contains problem solving procedures and how to further assistance. For more information, 
refer to the following sections.
• Problem Solving Procedure on page 166
• Scan to Server (WorkCentre 3325DN/3325DNI) on page 167
• LDAP on page 169
• Fax on page 170
• Printing on page 171
• Connectivity on page 172
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Problem Solving Procedure

This section enables you to identify the network-related machine problems. Use the following steps to 
identify and solve the problem. If the problem is not network related, refer to the User Guide for 
corrective action.

1. Resolve any local copier or fax problems first. Perform the corrective action that is recommended 
by the User Guide. Do not attempt to resolve a network problem if the local copier and fax 
functions are not operating correctly.

2. Check that the machine has power and it is switched on.
3. Check that the network cable is connected to the machine.
4. Check that the network cable is connected to the workstation.
5. Check that the correct print driver for the machine is selected at the workstation.
6. Check that the software application being used to send print jobs is set up correctly.
7. If printing and faxing documents are not available from a workstation, re-install a print driver on 

the workstation.
8. Call the local Xerox Welcome Center, where a representative will assist in the diagnosis and 

solution of the problem.
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Scan to Server (WorkCentre 3325DN/3325DNI)

Problem Action

I cannot scan on the machine. 1. Ensure that the FTP or SMB scan filing location, user account 
and password are correctly configured on the machine.

2. Ensure that the user account has read and write access to the 
scan filing location.

3. At a workstation on your network, login to the scan filing 
location with the user account and copy a file into the 
location. If you cannot do this, the Xerox machine will not be 
able to scan to this location.
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Scan to Server (WorkCentre 3325DN/3325DNI)
I cannot scan to a FTP server 
(WorkCentre 
3325DN/3325DNI).

Check that the FTP service is configured correctly:

1. Open a command prompt window from your workstation:
a. Select Start.
b. Select Run.
c. Enter cmd.
d. Select the OK button.

2. In the Command Prompt window, enter ftp then enter a 
space, then enter the IP Address of your FTP Server. For 
example: C:\ftp 192.221.13.4 (where the IP Address of your 
FTP server is 192.221.13.4).

3. Press Enter on your keyboard.
4. At the 'User' prompt enter the username for the account you 

created for the machine scanner. For example: User 
<192.221.13.4:<none>>: xerox (where the Username is 
xerox).

5. At the 'Password' prompt enter the password for the account 
you created for the machine scanner. For example: Password: 
machine (where the password for the account is 'machine').

6. A response of 'User Username logged in' will appear if the 
FTP server is correctly configured. If you cannot log in, open 
your FTP server settings and check that the Read and Write 
boxes are enabled, if applicable. If you have a 'Read Only' box 
- ensure that this is not enabled. 

7. Check the User account and password are correctly 
configured.

8. Check the User account has the appropriate rights to access 
the directory where scans are filed.

If you are able to log in to the FTP server, try creating a directory in 
the scan directory to check write access. To do this:

1. Within the Command Prompt screen, log in to your FTP server 
using the steps above.

2. Type mkdir xerox to create a directory called xerox.
3. A response of 'MKD Command Successful' will appear if the 

directory has been created. If 'Permission denied' appears, 
ensure that the User account has full read and write access 
rights to the scanning directory (repository).

4. Type rm xerox to delete the directory called xerox.
5. Type quit to end the FTP session.
6. Type exit to close the command prompt window.

Problem Action
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LDAP
LDAP

Problem Action

I cannot access the LDAP 
Address Book.

Ensure that the LDAP Server information is configured correctly 
within Internet Services.

The time taken to perform a 
search exceeds the maximum 
limit.

The machine contacted the LDAP Server, but the time to perform 
the search exceeds the maximum search time defined by the 
Administrator. 

1. Enter a more specific name at the machine to refine the 
search.

2. Increase the number in the Search Timeout box to increase 
the time of the search. This is located within the Internet 
Services LDAP Server screen.

3. Verify there are no communication problems with the LDAP 
server.

The number of search results 
exceeds the limit set on the 
LDAP server.

The number of search results exceeds the limit set on the LDAP 
server.

1. Enter a more specific name at the machine to refine the 
search.

2. Increase the number in the Maximum Number of Search 
Results. This is the maximum number of addresses that will 
appear which match the search criteria selected by the User. 
Set the Maximum Number to one less than the LDAP server 
will allow. For example, if the LDAP server limit is 75, set the 
search results to 74 or less. This setting is located within the 
Internet Services LDAP Server screen.

No LDAP entries fit the search 
criteria entered by the User.

Verify the Search By is set to match the name syntax used in your 
environment. This setting is located within the Internet Services 
LDAP Server screen.
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Fax
Fax

Problem Action

I cannot use this feature on the 
machine.

Ensure the fax line is connected to an operational telephone line.

Ensure that the fax settings are correctly configured.

1. Press the Machine Status button.
2. Press the Up/Down arrow buttons to highlight Fax Setup; 

press OK.
3. Press the Up/Down arrow buttons to highlight Enable; press 

OK.
4. Verify that the Fax Setups has been correctly configured. 

Further information about the configuration of the Fax Setups 
can be found in Enable Fax from the Machine on page 81.
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Printing
Printing

Problem Action

I cannot print to the machine. 1. Ensure that there are no network connectivity problems with 
the Xerox machine.

2. Print a Test Page from the Xerox print driver to the machine to 
verify connectivity.

3. Ensure that the print server is functional.
4. Print a Configuration Report at the Xerox machine to Ensure 

that the network address information is correctly configured.
5. Ensure that the correct print driver is installed on the User's 

workstation.

The machine is printing slowly. 1. Configure the Xerox machine with an Ethernet speed that 
matches the speed set on your hub or switch.

2. Ensure that the correct print driver is installed on the User's 
workstation.
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Connectivity
Connectivity

Problem Action

The machine is not available on the network. Network Connectivity

1. Print a Configuration Report at the machine 
to ensure that the network address 
information is correctly configured.

2. Connect to the machine’s IP address from a 
web browser to check connectivity.

3. Ensure that the machine is configured with 
an Ethernet speed that matches your hub or 
switch.

4. Ensure that the machine's Ethernet cable is 
correctly patched in at the hub/switch.

5. Ensure that the machine's Ethernet cable is 
functioning.

6. Ensure that other computers on your 
network can communicate.

The machine has an incorrect IP Address. Test TCP/IP Connectivity

1. Ping the address of the machine from a 
command prompt window.

2. If you receive a reply, the machine may be 
configured with a duplicate IP Address. 
Unplug the Ethernet cable from the machine 
and ping the IP Address again. If you still 
receive a reply, re-connect the Ethernet 
cable.

3. If you do not receive a reply when you ping 
the machine's IP Address, check the network 
cables at the machine and the computer 
that you are using to ping the machine.

4. Configure the Xerox machine with an 
Ethernet speed that matches the speed set 
on your hub or switch.

5. Ensure that the Ethernet cable is correctly 
patched in at the hub/switch.

6. Try a different Ethernet cable at the 
machine.

7. Check that other machines/computers can 
communicate over the network.
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Connectivity
Incorrect IP Address

In certain situations you may find the machine is 
configured with an incorrect IP Address or 
displays a network error. There are several 
possible causes of this:

1. When the machine boots up it discovers that 
it has been configured with an IP Address 
that is owned by another machine. 

Solution - Configure the machine with a unique 
IP Address.
2. The machine cannot connect to the DHCP or 

BootP server. The machine will use AutoIP to 
establish an address. 

Solution - Check the DHCP or BootP server works 
correctly. Configure the printer with a static IP 
Address. 
3. The printer has an IP Address of 169.254.x.x. 

Solution - The machine cannot connect to the 
DHCP or BootP server. The printer has used 
AutoIP to establish an address. Check the DHCP 
or BootP server works correctly. Configure the 
printer with a static IP Address.

Note AutoIP (AutoNetting) When DHCP or 
BootP are enabled on the machine, AutoIP is 
automatically enabled. If a DHCP or BootP 
server does not respond with an IP Address, 
the machine will use AutoIP to configure its 
own IP Address in the 169.254.0.0 range. 
When the machine connects to the DHCP or 
BootP server it will obtain a dynamic IP 
Address as normal. 
If the machine is configured with a static IP 
Address, it will not use AutoIP.

I cannot access Internet Services. 1. Ensure that the Xerox machine is configured 
with a valid IP Address.

2. Ensure HTTP Activate is enabled within the 
Machine Status > Network Settings area at 
the User interface (UI) screen.

3. Within your web browser, set the option to 
bypass the proxy server for local addresses.

Problem Action
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Appendix A

Management Information Base (MIB)

A MIB (Management Information Base) is a database of objects that can be accessed by a network 
management system. 

Xerox public MIBs are located at: http://origin-download.support.xerox.com/pub/drivers/MIBs/

Customers can download the MIBs and use their SNMP tool to obtain the required information.

Note All information presented on the Local UI display is also presented in the MIB and 
CentreWare Internet Services. This includes e-mail addresses, phone numbers and passwords as 
they are being entered. If this presents a security concern, Xerox recommends enabling the 
SNMPv3 and the IP Filtering security feature in order to control remote access to the device.
For SNMPv3, refer to SNMPv3 on page 123 and for IP Filtering, refer to IP Filtering on page 125.
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